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DSLR Remote Pro for Windows

DSLR Remote Pro for Windows

Overview

DSLR Remote Pro for Windows allows the Canon EOS digital SLRs to be operated tethered to a PC
using a USB or FireWire cable. All of the camera's controls remain fully operational when connected to
the PC and pictures can be taken directly using the camera's shutter release or remotely from the PC.
It is advisable to use a mains DC adaptor when using DSLR Remote Pro for Windows for extended
periods or when using the time lapse features. If the camera is located a long way from the PC or is
not easily accessible it is essential that there is a way of turning the power to the camera on and off.
Then if there is a communication failure between the camera and PC it is possible to turn everything

off and to start again.

Windows Vista and Windows 7

DSLR Remote Pro for Windows fully supports Windows Vista and Windows 7.

Drivers for for older camera models for Windows Vista and Windows 7 can be downloaded from
Canon's website: http://www.usa.canon.com/consumer
Click on "Download Library" to download the drivers for your camera. Newer cameras like the Canon

EOS 40D, 50D, 60D, 1D Mark 1V, Rebel T3I/EOS 600D etc. don't require drivers to be downloaded for

Windows XP, Windows Vista or Windows 7.

Please note: Some older models can't be controlled on Windows Vista but can be controlled on

Windows XP. Please see the table below for a list of supported camera models and operating

systems:

Camera Model Windows 7 Vista XP 2000
Canon EOS-1Ds Mark Il yes yes 32-bitonly | vyes
Canon EOS-1Ds Mark Il 32-bit only | 32-bit only | 32-bit only | yes
Canon EOS-1Ds no no 32-bitonly | vyes
Canon EOS-1D Mark IV yes yes 32-bit only no
Canon EOS-1D Mark Il yes yes 32-bitonly | vyes
Canon EOS-1D Mark IIN 32-bit only | 32-bit only | 32-bitonly | yes
Canon EOS-1D Mark Il 32-bit only | 32-bit only | 32-bitonly | yes
Canon EOS-1D no no 32-bitonly | yes
Canon EOS 5D Mark Il yes yes 32-bitonly | vyes
Canon EOS 5D 32-bit only | 32-bit only | 32-bit only | yes
Canon EOS 7D yes yes 32-bit only no
Canon EOS 60D yes yes 32-bit only no
Canon EOS 50D yes yes 32-bit only no
Canon EOS 40D yes yes 32-bitonly | yes
Canon EOS 30D yes yes 32-bitonly | vyes
Canon EOS 20D 32-bit only | 32-bit only | 32-bitonly | yes
Canon EOS 10D no no 32-bitonly | vyes
Canon EOS 1100D/Rebel T3/Kiss yes yes 32-bit only no
X50
Canon EOS 1000D/Rebel XS/Kiss F yes yes 32-bit only no
Canon EOS 600D/Rebel T3i/Kiss X5 yes yes 32-bit only no
Canon EOS 550D/Rebel T2i/Kiss X4 yes yes 32-bit only no
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Canon EOS 500D/Rebel T1i/Kiss X3 yes yes 32-bit only no
Canon EOS 450D/Rebel XSi/Kiss X2 yes yes 32-bitonly | yes
Canon EOS 400D/Rebel XTi/Kiss X yes yes 32-bitonly | yes
Canon EOS 350D/Rebel XT/Kiss N 32-bit only | 32-bit only | 32-bitonly | yes
Canon EOS 300D/Rebel/Kiss Digital no no 32-bitonly | yes
Notes:

1. The EOS-1D Mark Il, EOS-1D Mark Il N and EOS-1Ds Mark Il only support tethered operation using
the FireWire interface and can't be operated via the USB interface. It isn't possible to connect to the
camera if CFn 2 is set so that the camera doesn't fire without a memory card and no memory card
is in the camera.

2. Canon EOS 5D: for best results please set "Use latest Canon libraries..." in Preferences

3. Canon EOS 30D and Canon EOS 400D/Rebel XTi: Save to Camera & PC does not save images to
the camera's memory card due to a bug in the camera firmware

WARNING: Taking pictures from the camera and saving them to the camera’'s memory card and the
PC is not recommended with the EOS D60, EOS 300D Digital, EOS Digital Rebel and EOS Kiss
Digital. The camera may become unstable and crash or cause DSLR Remote Pro for Windows to
crash and images may be lost.

Please ensure you are using the latest firmware for your camera and the latest USB or FireWire
drivers are installed on your computer. These can be downloaded from Canon's website: http://
consumer.usa.canon.com (click on the "Download library" button). Please also check that the camera
is set to "Normal" communication mode and not "PTP" before connecting to it using DSLR Remote Pro
for Windows (this can be set via the camera's menus).

Installing and Registering DSLR Remote Pro for Windows

Installing the software

The latest version of DSLR Remote Pro for Windows can be downloaded from www.breezesys.com. If
you are upgrading your copy of DSLR Remote Pro for Windows please uninstall the old version first
and then install the new version. You shouldn't need to re-enter your registration code, but it is a good
idea to keep a copy just in case.

To install DSLR Remote Pro for Windows simply run the setup program and follow the on-screen
instructions. DSLR Remote Pro can be uninstalled using the standard Windows "Add/Remove
Programs" dialog available from "Control Panel".

In order to be able to connect to the camera you must also install the Canon USB or WIA drivers from
the CD that came with your camera. The latest Canon USB drivers can also be downloaded from
http://consumer.usa.canon.com

Checking for updates

You can check for updates by selecting "Check for updates online". This will connect to the internet
and display details of the latest version DSLR Remote Pro in your web browser. Alternatively go to the
DSLR Remote Pro for Windows page on our website: http://www.breezesys.com/DSIrRemotePro

Registering the software

Unregistered copies of DSLR Remote Pro for Windows are fully functional and may be evaluated for
up to 15 days after which time they will not run. To purchase a license for DSLR Remote Pro please
visit our website: http://www.breezesys.com/DSIrRemotePro. You will be sent an email containing your
registration details when your payment has been received.
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Installing and Registering DSLR Remote Pro for Windows 5

To register DSLR Remote Pro for Windows run the application and click on the "Enter Key" button
when the dialog below is displayed:

Then enter your registration name and code exactly as they appear in your registration email. You may
find it easier to cut and paste the registration code directly from your registration email to avoid
mistakes when entering it. Please keep a copy of your registration email safe in case you need to re-
enter your registration details.

3 Main Window

The Main Window

The main window shows the main camera controls together with a large preview display and a
histogram for assessing exposure. The main camera settings can be changed using the controls down
the left hand side of the main window. Other settings are available from the menus.
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3.1

Screen shot of DSLR Remote Pro for Windows main window showing optional focus point overlay
display

Release and Preview Buttons

Release Button

Click on the Release button (or press F8) to take a picture. The picture is automatically downloaded to
the PC, displayed in the main window and saved to disk. Images can be stored on the PC's hard disk,
on the camera's memory card or both. When DSLR Remote Pro for Windows is run it always defaults
to saving images to the PC only. Please select the appropriate option from the "Camera" menu if you
wish to use a different setting.

Note: No picture is taken if the camera is set to auto-focus and is unable to focus.

Preview Button

Click on the Preview button (or press F9) to take a picture in preview mode. The picture is taken as a
small JPEG with normal quality so that it is downloaded to the PC quickly. The picture is not stored on
the PC's disk or the camera's CF card.

Shutter Release Button

The shutter release button displayed below the histogram simulates pressing the shutter release on
the camera and is only available with the Canon EOS 50D, Canon EOS 7D, Canon EOS 5D Mark Il
and later cameras.

Move the mouse pointer over the shutter release button to simulate half pressing the camera'’s shutter
release. Normally this will activate the camera's auto focus system (depending on the camera's
settings).

Press the shutter release button to simulate fully pressing the camera's shutter release. This will take a
single picture if the drive mode is set to single shot or a series of pictures if the drive mode is set to
continuous shooting. Pressing the shutter release button can also be used to take photos when mirror
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Main Window 7

lockup is selected.

Remote Manual AF Mode

Recent cameras with live view have the option to take pictures without activating the camera'’s auto
focus. To use this option set the AF mode to "Remote Manual" in the "AF Mode:" dropdown list in the
main window.

3.2 Reviewing and deleting images

Reviewing Previous Images

You may review previous shots by pressing the "<- Prev Image" and "Next Image ->" buttons or by
using the left and right cursor keys. The main and preview images displays are updated to display the
selected image together with the histogram display. You can delete previously taken shots in the
normal way. To help identify which shot is being displayed the status bar shows the filename of the
image and its number in the sequence e.g. [3 of 5].

When a picture is taken the display is updated to show the new shot.

Deleting Images

Press the Delete key to delete the current picture. If the picture was saved to disk it is deleted from the
disk and removed from the display.

Note: Pictures saved to the CF card are not deleted.

3.3 Changing camera settings

Changing Camera Settings

The camera settings can be changed using the controls in the main window or directly using the
camera's controls. When the settings are changed on the camera they are updated and displayed in
the main window. Not all controls can be changed in all camera modes (e.g. the shutter speed can
only be set in Manual and Tv exposure modes) and so some controls are "grayed out" when they are
not applicable.

Operation is more reliable if "Ignore camera updates” is selected from the Camera menu when taking
pictures using the camera's controls. When this is selected the settings shown in the main window
display are not updated to reflect changes in the camera's setting. You can update the settings display
by pressing F5.

Notes

1. The lens can only be zoomed by physically turning the zoom ring on the lens

2. Depending on the camera model the focal length display may not be updated in the main window
until the next picture is taken

3. You can only switch between manual and autofocus using the switch on the lens

4. There is no way to take a exposure reading and display it in the main window without taking a test
shot

5. The exposure mode for the EOS-1D series cameras can be set from the PC. For other camera
models it can only be selected by turning the mode dial on the camera

6. The flash exposure compensation, drive mode and AF mode can only be set using the camera
controls when using a Canon EOS-1D and 1DS (also Kelvin color temperature for the EOS-1D).
This is a limitation of the cameras' firmware and may be adjustable from the PC in a future release if
Canon release new firmware.

34 Full screen mode

Full Screen Mode
Press F11 or select "Full Screen” from the view menu to display images in full screen mode. Press the
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3.5

3.6

Escape key or F11 to exit full screen mode.

In full screen mode the images fill the screen. The following keyboard short cuts are available when in
full screen mode:

F7 View image

F8 Release the shutter and save the image

F9 Take preview shot

F11/Esc Exit full screen mode

Delete Delete current image

Cursor left Display previous image

Cursor right Display next image

Ctrl+C Toggle caption display on and off

Ctrl+F Toggle focus point overlay display on and off
Ctrl+G Toggle grid overlay display on and off
Ctrl+wW Toggle black and white display mode on and off

Bulb Mode and Mirror Lockup

Bulb Mode and Mirror Lockup

Timed bulb exposures controlled from the PC are available with cameras from the Canon EOS-1D
Mark Il onwards (at the time of writing this also includes the Canon EOS 40D, Canon EOS 50D,
Canon EOS 60D, Canon EOS 7D, Canon EOS 600D/Rebel T3i, Canon EOS 550D/Rebel T2i, Canon
EOS 500D/Rebel T1i, Canon EOS 450D/Rebel XSi, Canon EOS 1100D/Rebel T3, Canon EOS 1000D/
Rebel XS, Canon EOS 5D Mark I, Canon EOS-1D Mark Ill, Canon EOS-1D Mark IV and Canon EOS-
1Ds Mark 111). To take a bulb exposure first set the camera shutter speed to "bulb". Then either press
the "Release" button to start the exposure and again to end it or select the "Time-lapse/bulb
shooting..." option from the Camera menu.

It is not possible to use bulb mode with older cameras when triggering the shutter release from the PC.
This is a limitation of the camera not DSLR Remote Pro for Windows. Pictures can still be taken in
bulb mode by pressing the camera'’s shutter release button.

Mirror lockup can be used with all cameras that support mirror lockup if the picture is taken by
pressing the camera's shutter release or by using a remote release cable. Some older cameras (e.g.
Canon EOS 10D) can use mirror lockup and be triggered from the PC. With these cameras the mirror
will flip up and the picture will be taken after a 2 second delay.

Canon EOS 50D, Canon EOS 7D, Canon EOS 5D Mark Il and later models:
Pictures can be taken from the PC with mirror lockup enabled by pressing the shutter release button
which is located in the main window below the histogram display.

Auto Bracketing

Auto Bracketing

DSLR Remote Pro for Windows has flexible settings for auto bracketing (taking a sequence of shots
using different exposure settings) which simplify the taking of shots which are later combined together

to form a single HDR (high dynamic range) image. To enable auto bracketing select the "Auto-bracket"
checkbox and then click on the "Settings..." button to display the auto bracket settings dialog below:
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Main Window 9

You can set the number of shots in the sequence using the first dropdown list. Then set the number of
exposure stops should separate each shot. This can be 1/3, 2/3, 1, 1 1/3, 1 2/3 or 2 stop per shot
depending on your camera's settings (if your camera is set to use 1/2 stop increments instead of 1/3
stop increments selecting a value of 1/3 or 2/3 stop increments will result in 1/2 stop increments being
used).

The different exposures are set using the camera's exposure compensation control if the one of the
auto exposure modes is selected. If manual exposure mode is selected the exposure will be varied
using either the shutter speed or the aperture according to the settings in this dialog. Normally it is
better to keep the aperture constant (and hence the depth of field) and vary the shutter speed.

DSLR Remote Pro for Windows can optionally run a command at the end of the auto bracket
sequence to combine the shots. To do this click on the "Execute command at end of auto bracket
sequence" checkbox and enter the name of the program or script to run. In the screenshot above the
script "photomatix.bat" has been entered. This will run the Windows batch file "photomatix.bat" which
combines the images using Photomatix Pro (which can be purchased from http://www.hdrsoft.com)
and displays the result in BreezeBrowser Pro (http://www.breezesys.com/BreezeBrowser ). The batch
file can be found in the DSLR Remote Pro for Windows installation folder (usually C:\Program
Files\BreezeSys\DSLR Remote Pro for Windows) and makes use of the command line interface for
Photomatix Pro. Please use photomatix3.bat with Photomatix Pro 3.1 and photomatix2.bat with
Photomatix Pro 2.

Suggested procedure for auto bracketing:

1. Use a tripod and compose the shot as required

2. Switch to manual exposure mode and low ISO setting to maximize the quality

3. Set the required aperture (e.g. use a small aperture like f/16 for good depth of field)

4. Take a preview shot to determine the correct exposure (this can be judged by looking at the
histogram display). It may be necessary to take a number of test shots to get the correct exposure.
Adjust the exposure by changing the shutter speed

. Set the lens to manual focus and focus carefully

. Set the required number of shots and number of stops separating each shot (a 5 shot sequence
with 1 stop increments is a good start, more shots may be required if the brightness range in the

[e2Né)]
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10

shot is very large)
7. Press the "Release" button and DSLR Remote Pro for Windows will automatically take the

sequence

Auto exposure bracketing is particularly useful for product shots and for taking pictures of the interiors
of buildings. The photos below compare the results from a single exposure of the interior of a church
with an image which was blended from seven separate exposures taken using DSLR Remote Pro's
auto bracketing feature:

Photo of the interior of St Andrews Church, Sherborne St John, Hampshire, England.
(The image on the right was created by blending the auto bracketed images using a separate image
editor which is not part of DSLR Remote Pro for Windows)

The seven shot auto bracket sequence used to create the blended exposure above:

3.7  Grid and focus point overlays

Grid Display
To toggle the grid overlay on the preview image type Ctrl+G or select "Display Grid" from the "View"
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Main Window 11

menu. Select "Grid Settings..." from the "View" menu to display the "Grid Settings" dialog, shown
below:

Select the show print area checkbox to show the extent of a particular print size. For example most
digital SLRs shoot images with an aspect ratio of 3:1 which fits perfectly on a 6"x4" print but needs to
be cropped if it is printed on 10"x8" paper. You can display extent of a 10"x8" print by setting the print
aspect ratio to 10 x 8.

NOTE: The grid display is only displayed on the preview image and doesn't affect images saved to
disk.

Focus Point Overlay Display

To toggle the focus point overlay display type Ctrl+F or click on the "Display overlay" checkbox. When
the focus point overlay display is enabled the seven focus point areas and the viewfinder circle are
displayed over the preview image. Active focus points are displayed in red.

Focus points can be selected from the PC for all camera models except the EOS-1D and EOS-1DS.
This is a limitation of the Canon SDK and may change in a future release.

NOTE: The focus point overlay display is only displayed on the preview image and doesn't affect
images saved to disk.

3.8 Flashing highlight display

Flashing Highlight Display

Select "Flashing Highlights" from the "View" menu to display over-exposed areas by highlighting them
flashing on and off in black. The method of calculating the highlight values and the threshold at which
to start flashing them can be specified by selecting "Highlight Settings..." from the "View" menu. When
the highlight method is set to "Luminosity" the luminosity or brightness of the image is used to
calculate the highlight values. When it is set to "RGB value" the largest of the red, green and blue
channel values is used.

NOTE: The flashing highlight display is only available for images displayed in the main window. It is not
available in full screen mode or the image preview window.
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3.9

3.10

3.11

Screen blanking

Blanking the Screen

To avoid extraneous light from the computer display affecting the lighting setup the screen can be
blanked when taking a photo. To do this click on the "Camera" menu and select "Blank screen when
taking photo". When this option is selected the screen will be automatically blanked when the shutter is
released from the PC. The screen will be restored after the camera has finished taking the picture. The
screen may also be restored by clicking the left mouse button.

Editing Images and Editor Setup

Editing Images and Editor Setup

Right click on the image and select "Edit Image" to open the image in an image editor (or press F3).
For this feature to work you need to tell DSLR Remote Pro for Windows how to run the image editor by
selecting "Setup Image Editor" from the File menu.

Select the "Use the Windows Explorer '‘Open’' command" option to use the same editor or viewer as
when you open or double-click an image in Windows Explorer.

Select the other option and enter the command line in the edit box to specify a different editor.

Select "Automatically edit image when a photo is taken" to automatically load images into an editor
when they are taken. Please take care not to load too many images into your editor as Windows may
run low on memory causing the editor or DSLR Remote Pro for Windows to fail. You can specify
whether to automatically edit raw and JPEG files, raw files only or JPEG files only using the dropdown
list.

NOTES:

1. Only images saved to disk can be edited. Preview images cannot be edited.

2. Most image editors cannot open Canon raw files directly and will display an error message if you try
to edit a raw image.

Displaying Images in BreezeBrowser Pro

BreezeBrowser Pro v1.9.4.4 onwards

BreezeBrowser Pro will automatically monitor a folder and display new images as they are taken. It
can also automatically update a slideshow to display new images. To enable this select "Monitor folder
for chjanges and update display automatically" in BreezeBrowser Pro's preferences (under the General
tab).
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Main Window 13

BreezeBrowser Pro v1.9.4.3 and earlier releases

Images can be automatically displayed in BreezeBrowser Pro after they have been taken and
downloaded to the PC. To do this select "Setup image editor..." from the File menu and set it up to run
the command BBProDisplay.exe as shown below:

3.12 Adding comments and IPTC data

Adding Comments

Comments can be automatically added to images as they are taken by entering the comment text in
the edit box located above the histogram.

Comments may be edited in existing images by right clicking on the image and selecting "Edit
comments..." from the menu. Comments can only be edited in images that have been saved to the
computer's disk.

Adding IPTC Data

DSLR Remote Pro for Windows can be setup to automatically store IPTC data in raw and JPEG
images as they are taken (this option is only available when saving images to the PC's hard disk).
Select "Add IPTC data to images" from the "File" menu to enable this function. The IPTC data to be
stored in the image may be edited by selecting "Edit IPTC..." from the "File" menu and the dialog below
will be displayed:
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3.13

Click on the tabs along the top of the dialog to select the different IPTC data types. Settings may be
saved for future use by pressing the "Save to file..." button and loaded using the "Load from file..."
button.

IPTC data can be entered as normal text or as special tokens which are evaluated when the photo is
taken e.g. %Y for the year. Please see the IPTC tokens page for a list of the available tokens.

The Image Preview Window

To display an enlarged preview window select View Image from the Image menu (or press F7). The
image preview window can be left on the screen while more pictures are taken to monitor composition
or focus in critical areas e.g. the eyes of a model during a portrait session. The preview window is
automatically updated when the image in the main window changes.

The image can be scrolled by moving the scroll bars or by clicking the left button on the mouse and
dragging the image. If the image preview window is still displayed when a picture is taken it will be
updated to show the same area of the new shot. This is very useful for monitoring important areas of
the image e.g. a model's eyes when taking portraits.

When shooting JPEG images the preview is the same size as the final image. To avoid a lengthy delay
converting raw images the embedded JPEG is displayed (cameras that shoot CRW raw files) or the
associated JPEG when shooting in raw+JPEG mode with the EOS-1D and 1DS. The size of the
embedded JPEG for Canon EOS 10D raw files is set using the RAW+JPEG custom function (CFn 8).

NOTE: No image is displayed in the Image preview window when shooting in raw mode with an EOS-
1D or 1DS. This is because the raw file only contains a small preview image. Please select
Raw+JPEG mode if you wish to display images in this window.
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Main Window 15

3.14 Auto Reconnect

When auto reconnect is selected from the "Camera" menu DSLR Remote Pro for Windows will
attempt to reconnect to the camera every 5 secs if it becomes disconnected. DSLR Remote will
display a red screen saying "Not connected" to clearly indicate that the connection has been lost.

The connection to the camera will be lost if the USB or FireWire cable is removed, the CF card door is
opened, the camera is switched off or the battery becomes flat or is removed.

Warning: Do not disconnect the camera from the computer while images are being downloaded. This
may result in some images being lost and may confuse the USB or FireWire drivers making it
necessary to reboot the PC before reconnecting.

In fullscreen photobooth mode auto reconnect will automatically restart the photobooth mode, enable
the live view if required and display the "ready" screen when the camera is connected.

3.15 Suppress Image Display

Select this option from the "View" menu if you do not need the images to be displayed on the PC.
Selecting this option gives a slight improvement in the download speed when shooting multiple
pictures. This is useful if the pictures are being captured to the PC and then forwarded to some other
system e.g. by FTP to a picture desk.

3.16 Color Management

DSLR Remote Pro for Windows supports the color management of images displayed in the main
window and when printing photo booth images. Color management helps produce more accurate and
consistent colors when displaying and printing images. DSLR Remote Pro for Windows uses the
perceptual rendering intent for both the display and printing of images. A detailed explanation of color
management is beyond the scope of this help file.

Select "Color management settings..." from the File menu in the main window to display the color
management settings dialog:
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Color Management of displayed images

Select a suitable color profile for your monitor by clicking on the "..." browse button or clicking on the
"Use default monitor profile” button. Next select a suitable color profile for your camera. Normally this
will be the SRGB Color Space profile unless your camera is set to AdobeRGB in which case it should
be the AdobeRGB 1998 profile. Then select "Enable color management of displayed images" to
enable color management.

Please note: For performance reasons color management is only applied to images displayed in the
main and full screen windows. It is not applied to live images or images displayed in photo booth
mode.

Color Management of printed images

First select a suitable color profile for your camera as described above. Next select a suitable color
profile for your printer by clicking on the "..." browse button. Most printer manufacturers provide generic
color profiles for their printers, often with different profiles for different papers. Then select "Enable
color management of printed images" checkbox to color manage the printing of photos for more
accurate colors.

IMPORTANT: Please disable color management in the printer driver when selecting color
management in DSLR Remote Pro for Windows otherwise the colors may be adjusted twice.

Camera Settings

Select "Set date/time and owner string..." from the Camera menu to display the "Camera Settings"
dialog:

This dialog shows information about the camera and allows you to synchronize the camera'’s internal
clock with your PC's clock and set the Canon camera owner string.

Please note: It may not be possible to sychronize all Canon cameras with the PC's clock to the exact
second but it is possible for it to be no more than one second out of sync.

Select "Automatically synchronize clock when camera is connected" if you would like DSLR Remote
Pro for Windows to automatically synchronize the camera'’s clock to the PC's time each time it
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Camera Settings 17

connects to the camera.

5 Live View Display

Please note: Currently the live view display is only available with the Canon EOS-1D Mark IV, Canon
EOS-1D Mark Ill, Canon EOS-1Ds Mark Ill, Canon EOS 40D, Canon EOS 50D, Canon EOS 60D,
Canon EOS 7D, Canon EOS 5D Mark I, Canon EOS 600D/Rebel T3i, Canon EOS 550D/Rebel T2i,
Canon EOS 500D/Rebel T1i, Canon EOS 450D/Rebel XSi, Canon EOS 1100D/Rebel T3 and Canon
EOS 1000D/Rebel XS.

Select "Live View" or type Ctrl+L to select the live view display and display the windows below. If the
camera is not already in live view mode the mirror will flip up and the camera will enter live view finder
mode. The controls in the main DSLR Remote Pro for Windows window can still be accessed when
the live view window is displayed. If the live view window is covered by other windows it can be
displayed by typing Ctrl+L when the main DSLR Remote Pro for Windows window is displayed.
Closing the live view window will cause the camera to exit live view mode unless the live view image is
also being displayed on the camera's LCD. The window can be resized to display a larger live view
image.

With recent cameras the display of live view images on camera's LCD display can be turned on or off
by right clicking on live view display and selecting "Display live view on camera LCD" or by typing
Ctrl+D. Turning on the camera's LCD also enables the camera controls and activates the HDMI video
feed (these are normally disabled when live view is selected from the PC).

If the camera’s LCD is accidentally left on after closing the live view window it can be turned off by
typing Ctrl+D.

Note: The camera's LCD cannot be controlled remotely when using older camera models that do not
have HDMI connectors

© 2012 Breeze Systems Ltd



18

Live view images can either be displayed full frame as in the screenshot above or zoomed as shown
below. The white rectangle shows the area of the zoomed image. The position of the zoomed area
relative to the rest of the frame is also shown in the navigation window in the bottom left hand corner.
The zoomed area can be moved by clicking on the white rectangle and dragging it using the mouse or
by dragging the rectangle in the navigation window. Double click the left mouse button over the image
or the navigation window to move the zoomed area and switch to the zoomed view.

Click on the "Release" or "Preview" buttons to take a image or a preview shot. The shot will be
displayed in the main DSLR Remote Pro for Windows window.

The lens can be focused using the arrow buttons or by using the mouse wheel. The "<<<" button shifts
the focus nearer by a large increment, "<<" focuses nearer by a medium increment and "<" can be
used for fine adjustment. Similarly the ">", ">>" and ">>>" focus farther away by small, medium or
large increments.

The mouse wheel provides a very effective way to adjust the focus. When the Shift key is held down
the mouse wheel adjusts the focus in large increments. When the Ctrl key is held down the mouse
wheel adjusts the focus in medium increments and when no keys are held down the mouse wheel can
be used for fine focus adjustments. The lens can also be focused using the cursor left and right keys
with the Ctrl and Shift selecting medium or large increments respectively.

Please note: The lens should normally be set to the auto-focus setting for the focus controls to work.
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Some lenses, e.g. Canon EF 17-40mm F/4 L, can also be focused when the lens is set to manual
focus.

Select the "DoF preview" check box to stop the lens down to the currently selected aperture to assess
the depth of field.

Right click on the image to display a menu for enabling or adjusting the grid overlay display. The live
view shares the same grid overlay settings as the image display in the main window.

A live histogram can be displayed in the full frame view showing the intensity (or brightness) and the
red, green and blue channels. Right click on the histogram to enable or disable the display of each
channel.

Please note: The histogram display is only available when live view exposure simulation is set in the
camera's custom functions (CFn 1V:16 for the Canon EOS-1D Mark Ill, CFn IV:7 for the Canon EOS
40D) and the full frame live view display is selected.

Overlay

An optional overlay image can be displayed over the live view images to help composition e.g.
registration marks could be displayed to help align the camera when taking id photos. The overlay
image should be a PNG file with transparency information in the alpha channel. It should be in
landscape orientation with an aspect ratio of 3:2 e.g. 1024x680 pixels in size. Once a suitable overlay
image has been defined it can be displayed by right clicking on the live view image and selecting "Load
overlay image...". An example overlay image called example_overlay.png can be found in the DSLR
Remote Pro for Windows installation folder.
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The zoomed area can be moved by clicking the mouse on the image and dragging as required or by
by dragging the white rectangle in the navigation window. It can also be moved by double clicking in
the navigation window.

Double click on the live view image or uncheck the "Zoom" check box to return to the full frame view.

The camera controls are automatically disabled when live view mode is selected but the camera
settings can still be adjusted using the controls in the main DSLR Remote Pro for Windows window.
Press the camera’s "Set" button to display the live view image on the camera's rear LCD. In this mode
most of the camera's controls may be used to adjust the camera's settings and the shutter release
button can be used to take pictures.

Auto Focus

Type Ctrl+F to activate auto focus in the full screen or zoomed live view displays. During auto focus
the AF status is shown in the title bar of live view window. It may take several seconds for optimum

focus to be achieved and in some cases (e.g. where the contrast in the image is low or the live view
images are very noisy due to low light levels) it may not be possible to achieve accurate focus.

In main view the area defined by the white rectangle is used to define the auto focus area. The
rectangle can be dragged to a new position to auto focus in a different area of the live view image. In
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the zoomed view the central 1/5 area of the image is used for auto focus. The focus area is highlighted
in red during AF.

Hold down the Shift key when typing Ctrl+F to activate the auto focus using fine adjustments only for
fasting focusing if the image is nearly in focus already.

Limitations: Because it takes several seconds to auto focus in live view it is not suitable for handheld
shots or for moving subjects. Auto focus may fail if the image is very out of focus when AF starts, if the
focus area has poor contrast or if the live view images are very noisy due to low light levels. Lenses
which focus in large steps when using the fine focus settings (the "<" and ">" buttons) and lenses
which focus by different amounts when focusing nearer or farther may cause AF to fail to achieve
optimum focus in live view.

Remote Manual AF Mode and Live View AF Modes

Recent cameras support auto-focus in live view and have a number of different AF modes (e.g. quick
mode, live mode and face detect). These can be selected using the "AF Mode:" dropdown list in the
main window. When the AF mode is set to "Remote Manual" and the camera is triggered remotely
from the PC auto-focus will not be used.

EVF Upscaling

The size of the live view (aka EVF) images depends on the camera model e.g. mid to high end models
like the Canon EOS 50D are 1024x680 pixels, Canon EOS 450D/Rebel XSiimages are 848x560
pixels and Canon EOS 1000D/Rebel XS images are 768x512 pixels. By default the Live View window
will enlarge (or upscale) the images to fit the window. This can produce pixelated images or other
display artefacts depending on the amount of upscaling or the type of subject being photographed. If
this is a problem EVF upscaling can be disabled by right clicking on the image and deselecting "Allow
EVF upscaling”.

Mirroring and rotating the live view display

The live view images can be rotated by selecting one of the orientation settings from the View menu in
the main window. It is not possible for the computer to read the camera's orientation from the built-in
orientation sensor and so the "Use orientation sensor" setting will have the same result as the
"Landscape” setting.

The image can be mirrored by right clicking on the full frame live view image and selecting "Mirror
image" from the popup menu. This will mirror the image horizontally and is applied after the live view
image has been rotated.

Onion Skinning

Onion skinning is where the current live view image is displayed on top of a previous image help line
up a shot. This is very useful when taking stop motion animations and in other situations where it is

important to accurately line up the camera for consecutive shots.

Onion skinning is only available when the full frame view image is displayed. To start onion skinning
right click on the view image and select "Onion skinning" from the menu. By default the background

image is updated whenever a photo is taken but this behavior can be disabled if required.

The background image used for onion skinning can be saved and loaded to from the a file. This is
useful when doing stop motion animation and you wish to save the background at the end of the day
and load it again to continue work the next day. It also means you can save the background image,
edit it in an image editor to add reference marks and then load it back into the live view window.

Another use for onion skinning is when taking panoramas. The onion skinning background can be
offset to the left or right for panoramas taken in horizontal format or to the top or bottom for vertical
format. The background is offset by 60% and is used to help align the next shot in the panorama.

Please note: Onion skinning is not currently supported with the "Mirror image" option and will not work
properly if this option is selected.
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Motion Detection

The live viewfinder display can be used to feed images to Webcam Zone Trigger motion detection
software which instructs the camera to take a photograph when motion is detected. Applications
include security monitoring and wildlife photography. Webcam Zone Trigger motion detection software
is developed by a company called Omega Unfold and can be purchased from their website.

To use motion detection first connect the camera to your PC and run DSLR Remote Pro for Windows.
When DSLR Remote Pro for Windows is running and connected to your camera run Webcam Zone
Trigger and select "Connect to Breeze Systems PSRemote software". When live view is active you
should see the live view display from the camera in the Webcam Zone Trigger window. Now select
"Add Trigger" in Webcam Zone Trigger and a circle showing the area being monitored will appear in
the viewfinder window. Use the mouse to drag the circle to the area you wish to monitor. When motion
is detected the circle will turn blue and a picture will be taken. It make take a few seconds for the

camera to take the picture.

Arranging Windows

Type Ctrl+A to automatically arrange the live view and main windows. Repeatedly pressing Ctrl+A will

cycle through the following window layouts:

1. Main window resized to just show the controls and positioned on the left of the screen with the live
view window occupying the rest of the screen. This mode is useful for viewing the live view and
adjusting the camera settings from the computer.

2. Live view window filling the screen - useful for composing and focusing the image

3. Main window filling the screen - useful for viewing images that have been taken

Keyboard Shortcuts
The following keyboard shortcuts can be used when the live view is displayed:

Spacebar or F8
F9

Ctrl+F
Shift+Ctrl+F
Ctrl+L

Cursor left
Ctrl+Cursor left
Shift+Cursor left
Cursor right
Ctrl+Cursor right
Shift+Cursor right
Cursor up
Cursor down
Ctrl+O

Ctrl+B

Ctrl+A

Ctrl+z

Ctrl+Tab

Take a picture

Take a preview image

Activate contrast detect AF

Activate contrast detect AF using fine focus adjustments only
Close the live view window

Focus closer by a small increment

Focus closer by a medium increment

Focus closer by a large increment

Focus farther by a small increment

Focus farther by a medium increment

Focus farther by a large increment

Zoom the preview

Select full frame display

Toggle onion skinning on and off

Capture current live view image as onion skinning background
Arrange the main and live view windows

Zoom in/out

Cycle through: Controls+AF area display->AF display but no controls->live view
images only

Video Capture

Video capture is available using the following cameras: Canon EOS 5D Mark Il, Canon EOS 7D,
Canon EOS 1D Mark IV, Canon EOS 60D, Canon EOS 500D/Rebel T1i, Canon EOS 550D/Rebel T2i,
Canon EOS 600D/Rebel T3i and Canon EOS 1100D/Rebel T3

IMPORTANT: Please read the disclaimer at the bottom of this page before using video capture
with DSLR Remote Pro for Windows

General Operation
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Canon cameras can only capture video to the camera's memory card and with live view enabled. To
capture video with DSLR Remote Pro for Windows first make sure the camera has a memory card
with sufficient free space and the camera is setup for video capture (please see below for information
on how to setup each camera model for video capture). Next, live view should be selected and the
"Rec" button pressed to start and stop video capture. During video capture a small red circle together
with the approximate duration of the video is displayed in the bottom left corner of the live view image.
At the end of video capture a small thumbnail file will be downloaded to DSLR Remote Pro and
displayed in the main window. This thumbnail file has a .THM file extension and is for identification
purposes only - the main .MOV movie file is stored on the camera's memory card.

The main .MOV movie file is stored on the camera's memory card. To download the movie file to the
PC first close the live view window and then either select "Download movies..." from the Camera menu
or right click on the thumbnail image and select "Download movie". After a movie file has been
successfully downloaded it can be automatically deleted from the memory card to free up space (by
selecting the option to delete movie files in Preferences). The memory card can also be formatted by
selecting "Format memory card..." from the Camera menu. Please use this option with care as it will
erase the memory card and any images or movies that have not been downloaded will be lost.

The normal live view focus and histogram options are available during live preview and video capture.
The zoom option is only available during live preview and can be used to zoom into an area to check
the focus. The lens can be focused in small, medium or large steps using the <<<, <<, <, >, >> and
>>> puttons or by using the middle wheel on the mouse.

Canon EOS 5D Mark Il

Please use firmware version 2.0.4 or later for the best results. The latest camera firmware can be
downloaded from Canon's website.

In the camera settings the live view function setting should be set to "Stillstmovie" and the screen
settings should be set to "Movie display". The "Movie rec. size" should be set to the required resolution
and frame rate as these cannot be set remotely from the PC.

Select live view in DSLR Remote Pro for Windows (e.g. by typing Ctrl+L) and the live view window will
be displayed. This will show shaded areas defining the frame extent either above and below the image
if 1920x1080 resolution is selected or to the left and right if 640x480 resolution is selected (the
resolution is also displayed in the window title bar). Press on the "Rec" button to start recording a video
clip and a red circle together with the duration of the video will appear in the bottom left corner of the
live view display. Press the "Rec" button again to stop recording - the red circle and video duration will
disappear and a small thumbnail will be automatically downloaded to the PC and displayed in the main
DSLR Remote Pro window.

The camera's LCD needs to be turned on in order to use the camera'’s controls to capture video. This
can be done by right clicking on the live view display in DSLR Remote Pro for Windows and selecting
"Display live view on camera LCD" or by pressing the live view button on the camera. The "Set" button
can now be used to start and stop recording.

Canon EOS 1D Mark IV and Canon EOS 7D

The EOS 7D and EOS-1D Mark IV have a dedicated movie/camera switch on the back of the camera.
If this switch is in the movie position when the camera is switched on the start/stop button needs to be
pressed in order to be able to use live view. Videos can be captured from the PC with the movie/
camera switch in either position, but can only be controlled using the camera'’s start/stop button if the
movie/camera switch is in the movie position. The various options are described below:

Movie/camera switch in the movie position when camera turned on: run DSLR Remote Pro for
Windows and press the start/stop button on the camera once it has connected to the camera. Videos
can be started by pressing the start/stop button on the camera and stopped by pressing the start/stop
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button again. Videos can also be started and stopped from the PC by selecting live view (e.g. by typing
Ctrl+L) and pressing the "Rec" button.

Movie/camera switch in the camera position when camera turned on: video can be captured from
the PC by selecting live view (e.g. by typing Ctrl+L) and clicking on the "Video" button. The live view
images will display shaded areas defining the video extent and the video resolution and frame rate will
be displayed in the live view window title bar. Press on the "Rec" button to start recording video and
again to stop recording. Alternatively video mode can be selected by moving the movie/camera switch
on the camera to the movie setting - this will allow the camera's start/stop button to be used to start
and stop video capture.

The video resolution and frame rate can be selected from the PC by right clicking on live view display
in DSLR Remote Pro for Windows and selecting the required setting from the menu. Pease note that
the video resolution ad frame rate can't be changed during video capture.

Canon EOS 60D, Canon EOS 550D/Rebel T2i, Canon EOS 600D/
Rebel T3i and Canon EOS 1100D/Rebel T3

These cameras have a dedicated movie setting on the camera'’s exposure mode dial. Videos can be
captured from the PC with the exposure mode dial set to any setting, but can only be controlled using
the camera'’s record button if the exposure dial is set to the movie position.

If the camera’s exposure mode dial is set to the movie position video capture can be started by
pressing the record button on the camera and stopped by pressing the record button again.Videos can
also be started and stopped from the PC by selecting live view (e.g. by typing Ctrl+L) and pressing the
"Rec" button.

If the camera’s exposure mode dial is not set to the movie position video capture can only be
controlled from the PC. To do this first select live view (e.g. by typing Ctrl+L) and then press the
"Video" button. The live view images will display shaded areas defining the video extent and the video
resolution and frame rate will be displayed in the live view window title bar. Press on the "Rec" button
to start recording video and again to stop recording.

The video resolution and frame rate can be selected from the PC by right clicking on live view display
in DSLR Remote Pro for Windows and selecting the required setting from the menu. Pease note that
the video resolution ad frame rate can't be changed during video capture.

Canon EOS 500D/Rebel T1i

The EOS 500D/Rebel T1i has a dedicated movie setting on the camera's exposure mode dial and this
must be set to the movie position in order to be able to capture video. Please note that the Canon EOS
500D/Rebel T1i cannot be used for video capture from a PC without having access to the camera's
controls. In order to capture videos you must have access the camera to either turn the exposure
mode dial to the movie setting or to press the "Rec" button.

Exposure mode dial is set to the movie position when the camera is turned on: run DSLR
Remote Pro for Windows and press the start/stop button on the camera once it has connected to the
camera. If the "Save to camera only" option is selected in DSLR Remote Pro for Windows videos can
be started by pressing the start/stop button on the camera and stopped by pressing the start/stop
button again. Videos can also be started and stopped from the PC by selecting live view (e.g. by typing
Ctrl+L) and pressing the "Rec" button.

Exposure mode dial not set to the movie position when the camera is turned on: when DSLR
Remote Pro for Windows is run normal live view operation is available but video capture is not
possible. To enable video capture turn the exposure mode dial to the movie position. If the "Save to
camera only" option is selected in DSLR Remote Pro for Windows videos can be started by pressing
the start/stop button on the camera and stopped by pressing the start/stop button again. Videos can
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also be started and stopped from the PC by selecting live view (e.g. by typing Ctrl+L) and pressing the
"Rec" button.

The video resolution and frame rate is displayed in the live view window's title bar but can only be
changed from the camera.

Trouble shooting

If "busy" is displayed on the camera's LCD when the "Rec" or "Start/Stop" button is pressed it means
that movie mode needs to be selected on the camera (either by turning the exposure mode dial to
movie or by setting the movie/camera switch to movie).

If nothing happens when "Rec" or "Start/Stop" button is pressed on the camera please try selecting the
"Save to camera only" option in DSLR Remote Pro for Windows' Camera menu.

If the live view window does not display live view images you may need to press the "Rec" or "Start/
Stop" button on the camera.

Disclaimer

Canon currently does not support movie mode recording in its SDK and cannot support or guarantee
the operation, control and reliability of any third party software created from it, containing this
functionality. Canon also cannot be held liable for any damage or malfunction to any of its products or
loss of imaging data as a result of using the SDK outside of its designed parameter or such third party
applications created from it.

The support for video capture in DSLR Remote Pro for Windows makes use of undocumented
commands in Canon's SDK and cannot be guaranteed in any way. If you make use of this feature you
do so entirely at your own risk. Breeze Systems Ltd cannot accept any responsibility for any damage
that may be caused to cameras by using video capture or for the loss of video files or any other
malfunction.

7 Focus Stacking

Focus stacking is a technique for increasing the depth of field by taking a series of photographs with
different focus settings and then combining them together using the areas in focus from each image.
This technique is useful for macro and close-up photography, landscapes, product photography and
any other image where the depth of field is critical and the subject isn't moving.

The live view display in DSLR Remote Pro for Windows makes it very simple to automate the process
of taking a sequence of images with different focus settings by running a script. There is no need to
touch the camera and the mirror stays locked up during the sequence which minimizes the chances of
camera shake or movement. Once the pictures have been taken they can be combined using free
software such as CombineZM or commercial software like Helicon Focus (the example on this page
was combined using CombineZM).
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Image combined using CombineZM from a series of 40 individual shots shot taken with a Canon EOS
40D and Tamron 90mm macro lens set f/5. This is a full frame image which has been resized to fit on
the page and shows the edge effects to the left and right of the image resulting in the text being
reflected and also edge effects at the top and bottom. These can easily be cropped from the final
image but it is worth noting that it is a good idea not to frame the image too tightly when taking the

photos.
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Single shot taken with Canon EOS 40D with Tamron 90mm macro lens at f/5. A smaller aperture could
have been used to get greater depth of field but the image quality would be affected due to diffraction
effects if too small an aperture is used. One of the advantages of the focus stacking technique is the
lens can be set at its optimum aperture to give the best possible quality.

How to take the photos using DSLR Remote Pro for Windows

What do you need?

1. A Canon DSLR which supports live view e.g. Canon EOS 40D or Canon EOS-1D Mark 111

2. A copy of DSLR Remote Pro for Windows (you can use the free trial version for 15-days) and a USB
cable connecting your camera to your computer

3. A sturdy tripod to hold the camera steady while taking the sequence

4. AutoHotKey - a free scripting tool which can be downloaded from http://www.autohotkey.com

5. focus_stacking.ahk - an AutoHotKey script for taking the photos and adjusting the focus which can
be found in the DSLR Remote Pro for Windows installation folder (usually C:\Program
Files\BreezeSys\DSLR Remote Pro for Windows)

6. CombineZM - a free program for combining the images (download CombineZM)

First mount the camera on the tripod, select manual exposure mode and compose the shot, roughly
focusing the lens on the subject. Then connect the camera to your PC using the USB cable and run
DSLR Remote Pro for Windows. Activate the live view on the PC by typing Ctrl+L and use the mouse
wheel or cursor keys focus the lens on the nearest part of the subject. Finally, double click on the
focus_stacking.ahk file to run the script to take the photos. DSLR Remote Pro's live view window will
appear and a sequence of shots with different focus settings will be taken. Please don't touch you
computer while the sequence is being taken otherwise it may not work properly.

By default the focus_stacking.ahk script will take 30 images. This can be changed either by editing the
script using a text editor or by running the script from the Windows Command Prompt and specifying
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the number of images on the command line e.g.

C:\> focus_ stacking.ahk 15

Combining the images (or focus stack)

Run CombineZM and select "New" from the "File" menu. Locate the folder containing the images
taken earlier, select all the images in the file open dialog and click "Open". CombineZM will load the
images (this may take a few seconds). Then select "Do Stack" from the "Macro" menu to combine the
image (this may take a few minutes). When it has finished the combined image will be displayed in
CombineZM's main window. The image can be saved by selecting "Save Frame/Picture As" from the
"File" menu.

Time Lapse

Select "Time-lapse..." from the "Camera" menu to take time-lapse shots. With cameras from the
Canon EOS-1D Mark 1V, Canon EOS-1D Mark Ill, Canon EOS-1Ds Mark Ill, Canon EOS 5D Mark |l,
Canon EOS 7D, Canon EOS 60D, Canon EOS 50D, Canon EOS 40D, Canon EOS 600D/Rebel T3i,
Canon EOS 550D/Rebel T2i, Canon EOS 500D/Rebel T1i, Canon EOS 450D/Rebel XSi, Canon EOS
1100D/Rebel T3 and Canon EOS 1000D/Rebel XS onwards this dialog can also be used to control
timed bulb exposures.

The time lapse sequence can be set to start immediately or to start at a particular time and date. You
can either specify an end time and date for the time lapse sequence or the number of frames in the
sequence.

You can specify the interval between shots.

Note: If you set the interval to a time shorter than that required to take and download the picture the
sequence will run as fast as possible.
Press the "Start" button to start the time lapse sequence.

When using a camera that supports timed bulb exposures the "bulb exposure duration" settings will be
displayed in this dialog. These settings will be available if the camera's shutter speed is set to "bulb"
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otherwise they will be grayed out as shown in the screenshot above. The bulb exposure duration can
be set to any number of hours, minutes and seconds up to 24 hours and will start when the "Start"
button is pressed. The bulb exposure can be canceled at any time by pressing the "Cancel" button.

9 Photobooth Shooting

DSLR Remote Pro for Windows can be run as a photobooth where it automatically takes a series of
pictures and then prints them on a single sheet of paper.

Topics covered in this section:
Setting up the page layout
External flash mode
Touchscreen settings
Saving settings for future reference and using profiles
Print layout
Custom layout
Other output options
Images displayed to the user
Inactivity timer
Running external commands
Touchscreen keyboard
Keyboard shortcuts
Using external buttons for photobooth shooting
In operation
Green screen shooting
Live view overlay
How to create PNG images using Photoshop and Photoshop Elements
Video booth shooting

Please also see the series of articles on photobooth shooting on our website.

9.1 Photobooth Setup
Setting up the page layout

To setup photobooth operation select "Photobooth Settings..." from the File menu and the dialog below
will be displayed:
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First select the number of images to be taken and how they are arranged. This could be a single
image on one sheet of paper (1 image, 1 row, 1 column), a passport style strip of images (e.g. 4
images, 4 rows, 1 column), 2x2 grid of 4 images as shown above or any other arrangement of up to 20
images arranged in a grid. Alternatively select "Custom layout" and click on the "Settings..." button next
to the checkbox to position each image manually on the page (this is described in more detail later).

Next select the delay before taking each photo and how long the shot just taken is displayed on screen
when shooting in fullscreen photobooth mode (this can be disabled by setting the time to 0). After
taking each photo a preview can be displayed on the screen for a specified number of seconds (set
this to O to disable the preview). The delay before taking the first photo can be set to a different value
than that for the remaining photos. This is useful when using a touchscreen as it means a longer delay
can be set before the first photo to give people time to move back from the touchscreen.
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When the "Minimum duration in seconds before closing ‘processing' screen is set to 0 the 'processing'
screen will be close as soon as the data has been sent to the printer. The 'processing' screen can be
displayed for longer by adjusting this value. This is useful if you want to keep displaying a message
such as "Thank you! Your photos are being printed, please leave the booth now" for longer than it
takes to print the images.

The countdown text is displayed before shooting each image and is updated every second. The
following tokens can be used:

@imageNumber@ - the shot number in the photobooth sequence

@numberOfimages@ - the number of images in the photobooth seconds
@secsToNextPhoto@ - the number of seconds until the next photo in the sequence is taken

Select "Enable live view for fullscreen photobooth shooting" to display live view images in the
fullscreen photobooth shooting mode. The live view image can be mirrored so that the user sees the
image the same way round as when looking in a mirror. Use the height setting to resize the live view
images. The live view image can be displayed in portrait orientation by selecting one of the portrait
orientations from the View menu in the main window.

By default the live view images are displayed centered at the top of the screen with the count down text
beneath. The position of the live view images can be adjusted using the "Left offset" and "Top offset"
settings. These specify the offset in pixels from the left and top of the screen respectively. If the left
offset is set to -1 the live view display will be centered horizontally on the screen.

If the count down text offset is set to 0 the count down text is automatically displayed centered in the
spare space above or below the live view images (depending on whether there is more space above or
below the live view images). Please make sure there is enough space for the count down text when
setting the live view size and position.

Alternatively the countdown text can be manually positioned on the screen by setting the offset to a
non-zero value. This value is the number of pixels the text is offset from the top of the screen. If
required, the countdown text can be positioned so that it overlays the live view images.

The live view display can be cropped if required by selecting fullscreen photobooth mode and holding
down the Shift key and using the cursor left and right keys to increase or decrease the cropping.
Cropping removes equal amounts from the left and right of the live view image when displaying live
view images in landscape orientation and from the top and bottom when using portrait orientation.
When adjusting the live view cropping a status message showing the amount of cropping is shown
briefly in the bottom right hand corner of the screen.

Normally the live view display, if enabled, is shown before each image in the sequence is taken. When
the "Only display Live View images for the first shot in the sequence” option is selected live view
images are only displayed to the user before taking the first shot of the sequence and are hidden
during the rest of the sequence.

The live view display can be disabled during printing by selecting the "Disable live view when printing"
checkbox. Disabling the live view during printing and displaying a suitable message in the 'processing'
screen is a good way of encouraging people to leave the booth after the photos have been taken. For
example you could disable live view during printing, set the minimum duration before closing the
'‘processing’ screen to 15 secs and display the message "Thank you! Your photos are being printed
and will be ready outside shortly, please leave the booth now" by editing the 'processing screen

(processing.jpg).

Most Canon cameras don't use auto focus when live view is active. To allow auto focus to be used
select the "Disable live view when taking photo". This will disable live view immediately before taking
each photo, the camera will then auto focus as normal and live view will be re-enabled after taking the
photo. Please note that if the camera's auto focus system is unable to focus properly the camera will
not take the photo and the photobooth shooting sequence will fail.

The latest Canon cameras (Canon EOS 7D, Canon EOS 60D, Canon EOS 550D/Rebel T2i, Canon
EOS 600D/Rebel T3i and Canon EOS 1100D/Rebel T3) can auto focus when using live view. Setting
the AF mode in the main window to "Quick Mode" works in a similar way to using the "Disable live view
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when taking photo" option in DSLR Remote Pro for Windows. Auto focus can be disabled with these
cameras by setting the AF mode to "Remote Manual".

External flash mode: Studio strobes and external flashes which are not Canon E-TTL compatible can
cause the live view images to appear too dark and the flash to not be triggered when taking photos.
With a mid- to high-end camera such as a Canon EOS 40D, 50D, 60D, 7D or 5D Mark Il the dark live
view images can be overcome by disabling exposure simulation in the camera's live view settings and
disabling silent shooting mode will fix problems with the flash not being triggered.

Rebel series cameras (e.g. Rebel T3/EOS 1100D, Rebel T3I/EOS 600D, Rebel XS/EOS 1000D, Rebel
T1i/EOS 500D and Rebel T2i/EOS 550D) automatically select live view exposure simulation and silent
shooting mode when live view is active and these settings can't be disabled by the user. "External flash
mode" overcomes these limitations and allows external flashes and studio strobes to be used with
Rebel series cameras. When this option is selected the camera's exposure mode dial should be set to
"M" for manual exposure and the aperture should be set to the required setting for the flash (usually a
setting of f/8 or f/11 is best). When full screen photo booth mode is selected the brightness of the live
view images is adjusted automatically. It can also be adjusted manually using the up and down cursor
keys. It is recommended that the camera lens is set to MF (manual focus) or the AF mode set to
"Remote manual” in the main DSLR Remote Pro for Windows window when using external flash mode
to prevent auto focus problems from causing the photo booth shooting sequence to be interrupted.
Please note that there is a short delay restoring the live view after taking each picture when external
flash mode is selected. This can be hidden from users by enabling the option to preview each shot
after it is taken.

Select "Ask for confirmation before printing" if you want to be able to decide whether to print the
images or not. When this option is selected the print layout will be displayed on the screen with "Print"
and "Cancel" buttons in the top left hand corner. Users should click on the "Print" button (or press the
Enter key) to print the images or click on the "Cancel" button (or press the Esc key) to continue without
printing. If the touchscreen input mode is selected and touchscreen actions for confirm or cancel
printing are defined the "Print" and "Cancel" buttons will not be displayed. The touchscreen sensitive
areas can be displayed using the confirm_printing.jpg screen image.

If a confirm_printing.jpg screen image is in the photobooth images folder this will be used for the
background to the print confirmation window to allow instructions or touchscreen buttons to be
displayed.

If a printing_confirmed.jpg screen image is in the photobooth images folder this will be displayed if the
user selects printing. This allows the processing.jpg screen to show a message like "Processing,
please wait..." and the printing_confirmed.jpg to display a message like "Thank you, please leave the
booth now. You're photos are being printed outside."

There is a default timeout of 300 secs after which time the print will be automatically canceled. This
timeout is stored in the Windows registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothConfirmPrintingTimeout

The following start options are available:

"Keyboard only (ignore This is the default setting where the photobooth sequence can be started
mouse or touchscreen using the normal keyboard shortcuts e.g. F4

clicks)"
"Left click anywhere to This setting allows a mouse or a touchscreen to start the photobooth
start" sequence. The user simply needs to click the left mouse button or press

anywhere on the display if using a touchscreen

"Left click to start, right This setting allows a standard mouse to be used to start the sequence (left
click to toggle B&W click) or to toggle between B&W and color modes (right click)
mode"

"Left click top left to This setting is designed for touchscreens and requires the user to click in

start" the top left fifth of the screen to start the sequence. The ready.jpg image
should be edited to show the user where to touch the screen to start the
sequence.
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"Left click top left to This setting is designed for touchscreens and requires the user to click in

start color sequence, the top left fifth of the screen to start the sequence in color and the bottom

bottom left for B&W" left fifth to start it in black and white. The ready.jpg image should be edited
to show the user which areas to touch to start the sequence.

"Touchscreen" This setting allows up to 10 areas on a touchscreen to be given different
actions (described in more detail below)

Touchscreen Settings

Up to 10 areas can be defined on a touchscreen to control different photo booth settings such as
starting the sequence, switching between color and B&W, selecting the number of print copies etc.
First select the "Touchscreen” option in the "Start options" dropdown list and then click on the
"Settings..." button to display the touchscreen settings dialog:

Select the action using the dropdown lists on the left and the area on the touchscreen that activates

the action using the corresponding "Left", "Top", "Right" and "Bottom" edit boxes. The values entered

in the edit boxes are the screen coordinates in pixels with the origin in the top left corner. The example

in the screenshot above defines three sensitive areas on the touchscreen:

1. A square area 300x300 pixels in the top left corner of the screen which starts the photobooth
sequence (action is set to "Release")

2. A smaller rectangular area 300x150 pixels in size located below the first area which selects B&W
mode

3. A second area similar to item 2 which selects color mode

An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. This information is stored in
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the XML file saved after each shooting sequence. Use the dropdown list to select when the
touchscreen keyboard should be displayed and the "Test keyboard..." button to test it. Please see the
section describing the touchscreen keyboard for more details.

Saving settings for future reference and using profiles

Settings can be saved to file for future reference by pressing the "Save..." button and reloaded by
pressing the "Load..." button. This is makes it possible to define a number of different layouts which
can be selected before entering fullscreen photobooth mode. Please note that layout depends on the
size of the page which is affected by the printer settings. The values saved for one setup may not
produce the same results if a different printer is used or the page or resolution settings have changed.

The image download directory specified in preferences is not saved with the photobooth settings, but
you can use the tokens {photoboothDir} and {photoboothDir} to specify a different output directory for
each profile.

{photoboothDir} gives the full path of the photobooth images folder e.g. C:
\Photobooth\Layouts\MyLayout

{photoboothSubdir} gives the name of the photobooth subfolder e.g. if the photobooth images folder is
C:\Photobooth\Layouts\MyLayout then {photoboothSubdir} would become MyLayout

For example:

strips_profile: outputs standard photobooth strips to the default printer and uses C:
\Photobooth\Layouts\strips as its photobooth images dir

cubes_profile: takes four photos with the output set to 'none’ and uses C:\Photobooth\Layouts\cubes
as its photobooth images dir. Its output directory is then monitored by the Hot Folder Prints utility which
formats the images as a photo cube and sends them to a different printer.

To make this work the download directory in preferences could be set to C:
\Photobooth\Output\{photoboothSubdir}. This would save images from the strips_profile to C:
\Photobooth\Output\strips and the cubes_profile to C:\Photobooth\Output\cubes. The Hot Folder Prints
utility could then be setup to monitor the C:\Photobooth\Output\cubes folder for images and print them
out automatically when the required number of images are available.

Profiles allow you to use a keyboard shortcut (or touchscreen action) to automatically switch between
different sets of saved settings. To assign a profile to a keyboard shortcut click on the "Profiles..."
button at the bottom of the photobooth settings dialog to display the following dialog:
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Then click on "..." button for the appropriate profile and select a previously saved set of photobooth
settings. In the screenshot above profile 1 (keyboard shortcut SHIFT+CTRL+1) loads the settings file
photobooth_settings1.xml and profile 2 (keyboard shortcut SHIFT+CTRL+2) loads the settings file
photobooth_settings2.xml. Profiles can be used to allow users to selects different sets of photobooth
settings e.g. profile 1 might be a traditional layout of two columns of four images and profile 2 might be
a custom layout with one large image and several smaller ones. Profiles can be selected using the
touchscreen actions (described above) allowing a user to easily switch between different settings.

The tokens {photoboothDir} and {photoboothSubDir} can be used to specify the pathname of the
profile file to be loaded. The tokens are replaced with the value of current photobooth images folder
and provide a way to use more than 8 profiles.

The default profile setting can be used to ensure the photobooth starts up in a known state and is reset
to a known state at the end of each photobooth shooting sequence e.g. setting the photobooth to stills
mode, color photos and one set of prints.

Print layout

The print can have an optional background with a header and or footer image. When DSLR Remote
Pro for Windows prepares the image for printing it looks for the following files in the photobooth
images folder:
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background.jpg - optional image which is tiled to fill the background of the printed page

header.jpg - optional image which is centered and placed at the top of the page

footer.jpg - optional image which is centered and placed at the bottom of the page

left.jpg - optional image which is centered vertically and placed on the left of the page between the
header and footer

right.jpg - optional image which is centered vertically and placed on the right of the page between the
header and footer

middle.jpg - optional image which is centered vertically and placed between each column of images
image_overlay.png - optional image which is overlays each photo and uses transparency information
stored in the alpha channel

overlay.png - optional image which is overlays the page and uses transparency information stored in
the alpha channel

The images are then arranged in a grid which fills the printable area of the page less any space taken
up by a header or footer image. If the "Rotate image to maximize size" checkbox is selected the
images are rotated through 90 degrees if this would give a larger image. e.g. if the printable area for
the image within the grid is 80mm high and 50mm wide and the image was shot in landscape
orientation it would be rotated by 90 degrees to better fill the printable area.

If the number of images matches the number of rows the images can be repeated in each column by
selecting "Repeat images to fill empty columns”. This is useful when printing strips of images on paper
from a dye sublimation printer e.g. two copies of 4x1 strips on a sheet of 8x6 paper.

Custom layout

© 2012 Breeze Systems Ltd



Photobooth Shooting 37

Images can be manually laid out by selecting the "Custom layout" option which allows the size, position
and rotation of each image to be specified on the page. This allows complex layouts where the images
can be different sizes and don't need to be arranged in a grid. It is also simpler to setup for many less
complex layouts and often these can be achieved using a single background.jpg containing logos and
other graphics.

After selecting "Custom layout" click on the "Settings..." button to display the dialog below:

Up to 10 images can be positioned using the custom layout. The number of the image to be printed is
selected using the drop down list and the position of each image is specified in pixels on the page with
the point (0, 0) in the top left corner. The size is also specified in pixels. If both the width and the height
are specified the image will be sized to fill the width and height and any excess will be cropped.
Alternatively either the height or the width can be set to 0 and the image will be resized to match the
specified size without cropping.

For example: assuming an image size of 3456x2304 (the medium setting from a Canon EOS 500D/
Rebel T1i) the resultant image size for various width and height values would be:

width=1000, height=0: image resized to 1000 pixels wide by 667 pixels high (the app calculates the
height as 1000*2304/3456)

width=1000, height=800: images resized to 1204 pixels wide by 800 pixels high and then cropped by
equal amount left and right to give a final image size of 1000x800

width=0, height=800: images resized to 1200 pixels wide by 800 pixels high (the app calculates the
width as 800*3456/2304)
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Each image can also be rotated clockwise by between 0 and 359.9 degrees.

The settings in the screen shot above show how a simple layout of two strips of four images printed on
6"x4" paper using a 300 dpi printer can be defined.

The page size in pixels can be displayed by first setting up the printer to the required page size and
resolution and then pressing the "Print Info..." button. The layout can be previewed on computer
screen by pressing the "Preview" button or printed by pressing the "Print Test Page" button. Hold the
"Shift" key down and click on the "Print Test Page" button to print a printer calibration image with index
marks showing the extent of the printable area.

The "Preset layouts..." button can be used to help design a number of different popular layouts using
four photos. These include a double strip of four, a single strip of four, one large image with a row of
three smaller images below and two rows of two images. Simply select the layout you want, adjust the
page margins and image spacing and then press the OK button and the software will work out the
settings for you.

When the custom layout option is used the number of rows and columns, image border, rotate and
crop settings in the main photobooth settings dialog are not applicable and are grayed out.

Please note: The custom layout functionality was revised in DSLR Remote Pro for Windows v1.9 and
custom layout designs from previous releases may need to be updated if they use the "Copy left half of
page to right to create a double strip" option.

Other output options

The images can be sharpened by selecting the "Sharpen images" checkbox and specifying a
sharpening amount in the range 0 to 100. The amount of sharpening required depends on personal
taste, the camera and the printer. A value of around 75 is a good starting point.

If the "Crop image if required to fit the printable area" checkbox is selected the image will be cropped
to fill the printable area within the grid. e.g. if the printable area within the grid is square equal portions
of the left and right of the image will be cropped to make it square.

Photos can be printed in color, pure black and white or toned black and white by selecting the
appropriate option from the dropdown list headed "Print photos:". You can also switch between these
options when the software is running in fullscreen photobooth mode by using the following keyboard
shortcuts: Ctrl+C to select color, Ctrl+B to select black and white, Ctrl+T to select toning, Ctrl+W to
toggle between color and B&W and W to cycle through color, B&W and toning.

When the "toned" option is selected the hue and saturation settings can be adjusted when the software
is running in fullscreen photobooth mode by using the following keyboard shortcuts: Ctrl+cursor left/
Ctrl+right to adjust the hue and Ctrl+cursor up/Ctrl+down to adjust the saturation. A status message
showing the current settings is briefly displayed in the bottom right hand corner of the display when
adjusting the hue and saturation in fullscreen photobooth mode. Setting the B&W toning hue to 200
and the saturation to 40 is a good starting point for sepia toned prints.

Up to two captions can be printed by selecting the "captions" checkbox. Press the "Settings" button to
display the dialog below to setup the captions:

© 2012 Breeze Systems Ltd



Photobooth Shooting 39

Each caption can occupy more than one line if required and is left justified by default. Select the
"Center justify" checkbox to center justify multiple lines. The size, font, color and rotation (in degrees
clockwise) of the caption text can also be specified. The font size is calculated using the printer
resolution and so a 72 point font should give text one inch high (one 'point' is 1/72 of an inch). The
caption is printed in the selected font color with a transparent background. Tokens can be used in the
caption text to insert values such as %d for the date and %t for the time the sequence started,
{comment} for the comments entered in the main screen and {filename} for the filename used for the
JPEG copy of the print layout. Please see the section on tokens for a list of tokens available.

Enter the position for the captions as offsets in mm from the top and the left of the page.

The easiest way to see how this all fits together is to run DSLR Remote Pro for Windows and take
some test shots. First setup the printer settings by selecting "Printer Setup..." from the File menu and
then set basic photobooth settings using the setup dialog. The take a test sequence by pressing
Shift+F4 or selecting "Photobooth Test Shot" from the File menu. This will take a sequence of images
and create a test page which is saved as photobooth_test shot.jpg. Load this image into an image
editor (or BreezeBrowser Pro) to view the layout. Then make any changes to the background.jpg,
header.jpg, footer.jpg or overlay.png images and the photobooth settings and take more test shots
until you're happy with the layout.

Tip: To save having to setup the printer preferences every time DSLR Remote Pro for Windows is run
you can go to the Windows Control Panel, select "Printers and Faxes" then right click on the printer to
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change its preferences.

Some example layouts using four shots arranged in two columns of four:

With left.jpg down the left border, middle.jpg placed between the columns, right.jpg down the right

border and footer.jpg at the bottom
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Same layout as the first example but with no left.jpg or right.jpg images defining the left and right
borders
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Same layout as the previous example but with no middle.jpg image placed between the columns
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Same layout as the previous example but with a 2mm border around each image

43
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A custom layout where the size and position of each photo is specified individually

Images displayed to the user

If full screen mode is selected (by pressing Ctrl+F4 to enter full screen mode and display the ready
image) a series of images can be displayed to the user to show them what's happening and to
advertise the photobooth. These images are held in the same folder as the background, header and
footer images and are as follows:

ready.jpg - image displayed when DSLR Remote Pro for Windows is ready to take the next set of
photos

1.jpg, 2.jpg etc. - image displayed before taking the first, second, third etc. images together with the
text specified in the setting dialog

taking.jpg - image displayed for approximately 1 sec before taking each shot

release.jpg - optional image displayed as the photo is taken (live view is hidden when this screen is
displayed)

processing.jpg - image displayed after taking the photos while DSLR Remote Pro for Windows formats
and sends the page to the printer

reprinting.jpg - optional image displayed when reprinting photos (processing.jpg will be displayed if
reprinting.jpg isn't found)

camera_not_connected.jpg - image displayed when the camera is turned off or disconnected
welcome.jpg - image displayed when the inactivity timer has canceled live view or standby mode has
been selected by pressing F6

confirm_printing.jpg - optional background image when displaying print confirmation screen
printing_confirmed.jpg - image displayed if user selects printing from the print confirmation screen
keyboard_input_ok.jpg - image displayed if user selects 'ok’' from the on screen keyboard after the
photos have been taken

keyboard_input_cancel.jpg - image displayed if user selects 'cancel' from the on screen keyboard after
the photos have been taken

These images can be JPEGs containing any information you like and are displayed centered on the
display with a black background. The images 1.jpg, 2.jpg etc are displayed together with the text
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defined in the settings dialog which can be used to give a count down timer before each picture. The
text is displayed centered on the screen below the live view display, if applicable, as white text on a
transparent background. The following tokens can be used in the text:

@imageNumber@ - the number of the image in the sequence starting from 1
@numberOfimages@ - the number of images in the sequence
@secsToNextPhoto@ - the number of seconds until the next photo is taken

The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.

When using live view in photobooth mode the live view images will not be updated while the camera is
actually taking each picture. This will cause the live view display to freeze for a couple of seconds and
can confuse some users as it shows the live view just before the picture is taken and this will be
slightly different from the actual photo. To avoid this problem the live view display will be blanked out
when the photo is taken if you define a release.jpg image.

Audio prompts can be added by placing a WAV sound file in the photobooth images folder and giving it
the same name as prompt screen. For example to play a sound when the photobooth is ready copy a
WAV file named ready.wav into the photobooth images folder and it will be played when the ready.jpg
image is displayed.

Again, the easiest way to see how this works is to try it out. To do this run DSLR Remote Pro for
Windows then press Ctrl+F4 to display the ready screen. Then press Shift+F4 to take a test sequence
or F4 to take the pictures and print them.

A typical 4 picture sequence would be:
At startup: "ready.jpg" image displayed on screen and "ready.wav" played once (if present)

Sequence started: "1.jpg" image displayed on screen together with countdown text and "1.wav"
played once (if present)

Approx 1 sec before taking picture #1: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #1: preview image displayed for the required number of seconds (if enabled in
the settings) then "2.jpg" image displayed on screen together with countdown text and "2.wav" played
once (if present)

Approx 1 sec before taking picture #2: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #2: preview image displayed for the required number of seconds (if enabled in
the settings) then "3.jpg" image displayed on screen together with countdown text and "3.wav" played
once (if present)

Approx 1 sec before taking picture #3: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #3: preview image displayed for the required number of seconds (if enabled in
the settings) then "4.jpg" image displayed on screen together with countdown text and "4.wav" played
once (if present)

Approx 1 sec before taking picture #4: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
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After taking picture #4: preview image displayed for the required number of seconds (if enabled in
the settings) then "processing.jpg" image displayed on screen and "processing.wav" played once (if
present). During this time the images are formatted ready for output and either saved to file or sent to
the printer queue. When this has finished the screen goes back to the "ready.jpg" image and the
ready.wav sound file is played ready for the next sequence.

It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This makes it possible to show
the user which settings have been selected and could be used as part of a touchscreen menu system.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <bjc|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.

For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:

ready b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for:
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:

ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:

ready.jpg

So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1l.jpg, ready_b2.jpg,
ready b3.jpg.

When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Inactivity Timer

Using live view for long periods of time drains battery power and can cause the camera's sensor to
heat up. Most camera models will automatically cancel live view after 30 minutes to prevent
overheating. Fullscreen photobooth mode has an inactivity timer which will automatically cancel and
restart live view after 25 minutes to prevent the camera from canceling it. Alternatively full screen
photobooth mode can automatically cancel live view and display the welcome.jpg screen image if the
photobooth is not used for a preset time. Live view can also be canceled manually by pressing the F6
function key. Press the F6 function key to reactivate live view and return to ready.jpg screen when the
welcome.jpg screen is displayed.

The inactivity timeout in seconds is stored in the Windows registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothInactivityTimeout

This can be adjusted to make the timeout shorter if required. If it is set to 0 fullscreen photobooth
mode will automatically cancel and restart live view after 25 minutes of inactivity. Alternatively setting it
to a very large value (e.g. 360000) will have the effect of disabling the timeout.

Running External Commands

External commands can be used to customize the way the photobooth works e.g. by emailing images
or turning lights on and off. There are three different ways external commands can be run when
shooting in full screen photobooth mode:

1. After each photo is downloaded

2. When the photobooth screen changes during the photobooth shooting sequence

3. When the XML summary file is written after the photobooth output has been printed or saved
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Running commands after downloading each photo

To do this use the edit images option and select the command line option. Please note that the
photobooth shooting sequence will not wait for the command to be processed and so this isn't suitable
for running commands to modify images before they are printed.

Running commands when the photobooth screen changes (experimental)

This allows a command to be run each time the photobooth screen changes during the photobooth
shooting sequence. The full pathname of the screen image is passed as a command line argument to
the command e.g. C:\Program Files\BreezeSys\DSLR Remote Pro\Photoboothimages\ready.jpg. To
enable this two values need to be stored in the Windows registry: PhotoboothStatusCmdEnable and
PhotoboothStatusCmd (see below for details).

Running a command when the XML summary file is written (experimental)

This allows a command to be run after the photobooth output has been saved or printed and the XML
summary file has been written. The full pathname of the XML summary file is passed as a command
line argument to the command. To enable this two values need to be stored in the Windows registry:
PhotoboothStatusCmdEnable and PhotoboothStatusCmdXML (see below for details).

Windows registry settings

To enable the photobooth screen change or XML summary file commands the following
REG_DWORD value in the Windows registry should be set to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothStatusCmdEnable

The photobooth screen change command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothStatusCmd

The XML summary file command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothStatusCmdXML

Enter an empty string or delete the registry value for PhotoboothStatusCmd or
PhotoboothStatusCmdXML if you want to run one command but not the other. The values can be
edited using the Windows regedit utility or by creating a registry file like the one below, giving it a .reg
file extension and then double clicking on the file in Windows Explorer to copy the settings to the
registry:

Windows Registry Editor Version 5.00

[HKEY CURRENT USER\Software\BreezeSystems\DSLRRemotePro\100]

"PhotoboothStatusCmdEnable"=dword: 00000001

"PhotoboothStatusCmd"="C:\\Program Files\\BreezeSys\\DSLR Remote Pro\\PhotoboothImages\\status.exe"
"PhotoboothStatusCmdXML"="C:\\Program Files\\BreezeSys\\DSLR Remote Pro\\PhotoboothImages\\statusXML.exe"

9.2 Touchscreen Keyboard

An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. To enable the keyboard set
the photo booth start options in the photo booth settings dialog to "Touchscreen" and click on the
"Settings..." button. The touchscreen settings dialog will be displayed:
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Then select the required touchscreen keyboard option from the dropdown list: "Not displayed", "Display
at start of sequence" "Display at end of sequence". The touchscreen keyboard can be tested by

pressing the "Test keyboard..." button. The default keyboard layout will fill the screen and look similar
to the screenshot below:
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The text entered by the user is saved in the <user_data> tag (and the <user_data2> tag if two text
fields are defined) in the XML file written at the end of the photo booth shooting sequence. If any
checkboxes are defined (see below) their status will be saved in <chkbox1>, <chkbox2> etc. tags e.qg.
if the user selects the first checkbox the XML will contain <chkbox1>1</chkbox1>. The XML file is
saved in the same folder as the photos downloaded from the camera (see preferences) e.g.

<?xml version="1.0" ?>
<breeze systems photobooth version="1.0">
<photo information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user data>sales@breezesys.com</user data>
<photobooth images folder>C:\Photobooth\PhotoboothImages</photobooth images folder>
<photos>
<photo image="1">20110126 163719 1.JPG</photo>
<photo image="2">20110126 163719 2.JPG</photo>
<photo image="3">20110126 163719 3.JPG</photo>
<photo image="4">20110126 163719 4.JPG</photo>
<output>prints\20110126 163719.jpg</output>
</photos>
</photo_information>
</breeze systems_ photobooth>

There is a default timeout of 300 secs after which time the touchscreen keyboard will be automatically
canceled. This timeout is stored in the Windows registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothKeyboardTimeout

Customizing the keyboard

The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml
and putting this in the photo booth images folder. This gives control over the size and position of the
keys, the background color etc. A series of keyboard images can also be used if you need more
control of the appearance of the keyboard.
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The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by

first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like:

<?xml version="1.0" 2>
<breeze systems photobooth version="2.2">
<photobooth settings>
<keyboard>
<text point size>480</text point size>
<promptl>Please enter your email address:</promptl>
<textl y>411</textl y>
<textl x>50</textl x>
<textl w>300</textl w>
<background color>0x000080</background color>
<transparent_color>0x000080</transparent_color>
<text color>0xFFFFFF</text color>
<show cursor>0</show_cursor>
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>g</legend>
<shifted legend>Q</shifted legend>
<code>g</code>
<shifted code>Q</shifted code>
</key>
<key>
<left>186</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>w</legend>
<shifted legend>W</shifted legend>
<code>w</code>
</key>
<key>
<left>1296</left>
<top>840</top>
<width>160</width>
<height>89</height>
<legend>Shift</legend>
<shifted legend>Shift</shifted legend>
<code>Shift</code>
<shifted code>Shift</shifted code>
</key>
<key>
<left>400</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>Send email</legend>
<shifted legend>Send email</shifted legend>
<code>OK</code>
<shifted code>OK</shifted code>
</key>
<key>
<left>784</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>No thanks!</legend>
<shifted legend>No thanks!</shifted legend>
<code>Cancel</code>
<shifted code>Cancel</shifted code>
</key>
</keyboard>
</photobooth settings>
</breeze systems_ photobooth>

The <prompt1> tag defines the text that is displayed above the user input area and defaults to "Please
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enter your email address:". The <textl x> and <textl_ y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The width
in pixels of the user input area can be specified using the <textl w> tag.

Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_w> etc. tags
up to a maximum of 10 user input areas. When more than one user input area is defined users can
switch between the input areas by touching them. The currently selected input area is highlighted in
red.

The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).

The text entered by the user is stored in the <user_data>, <user2_data> etc. fields in the XML file
saved with the photos.

Up to 10 checkboxes can be added using the <chkbox1_prompt>, <chkbox1_x>, <chkbox1_y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1_prompt> or <chkbox1_prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>.
The <chkbox1_x> and <chkbox2_y> tags specify the position of the checkbox.

The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML file saved with the
photos.

The <background_color> tag specifies the background color of the window and the <key text color>
specifies the color for the prompt text and key legends.

The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).

The optional <text_background_color> tag specifies the background color for the user input areas. The
default value if this tag is omitted is white (OXFFFFFF).

The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.

All colors should be hexadecimal RGB values e.g. 0x000000 for black, OxFF0000 for red, 0OXxO0FFO0
for green, 0XO000FF for blue, OXFFFFFF for white.

The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set thisto 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of spaces.

The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width and
height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed.

The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:

"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed

"OK" - closes the keyboard window and returns the user input

"OK all" - closes the keyboard window and returns the user input if all the input fields contain some text
"Cancel" - closes the keyboard window and cancels the user input

The keyboard.xml can just include additional settings and the touchscreen keyboard will use the
default layout (shown above) if it doesn't contain any <key> tags. For example you could use the
default keyboard layout and add a checkbox to ask users whether they consent to their photos being
uploaded to a website using the keyboard.xml file below:

<?xml version="1.0" 2>
<breeze systems photobooth version="2.3">
<photobooth settings>
<keyboard>
<chkboxl prompt value="0">I agree to my photos being posted on a web site</chkboxl prompt>
<chkboxl x>38</chkboxl x>
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<chkboxl y>70</chkboxl y>
</keyboard>
</photobooth settings>
</breeze systems_ photobooth>

Keyboard images

Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the photo booth images folder. The keyboard images should be named as follows:

keyboard_uppercase.tif - keyboard image showing upper case key legends
keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed

keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard _uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).

Please take care that the keys are in the same positions in each of the keyboard images and that
these also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.

Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.

Keyboard Shortcuts
The photobooth mode in DSLR Remote Pro for Windows can accept the following key presses:

Esc - exit full screen photobooth or video booth mode and return to the main DSLR Remote Pro for
Windows screen

F2 - switch to B&W mode and start the photobooth sequence

F3 - switch to color mode and start the photobooth sequence

F4 - start the photobooth sequence using the current B&W or color setting
F5 - same as F4

F6 - reactivate live view and display ready.jpg screen if previously canceled due to inactivity or cancel
live view and display welcome.jpg screen if live view currently active

F9 - switch to stills photobooth mode and start the photobooth sequence
Ctrl+F1 - select the camera's user 1 picture style

Ctrl+F2 - select the camera's user 2 picture style

Ctrl+F3 - select the camera's user 3 picture style

Ctrl+F4 - select the camera's standard picture style

Ctrl+F5 - select the camera's portrait picture style

Ctrl+F6 - select the camera's landscape picture style

Ctrl+F7 - select the camera's neutral picture style

Ctrl+F8 - select the camera's faithful picture style

Ctrl+F9 - select the camera's monochrome picture style

S - cycle through available picture styles

Ctrl+B - switch to B&W mode but don't start the photobooth sequence
Ctrl+C - switch to color mode but don't start the photobooth sequence
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Ctrl+K - switch to color mode but don't start the photobooth sequence (alternative for Ctrl+C)
Ctrl+R - reprint the last set of photos

Ctrl+T - switch to B&W (toned) mode but don't start the photobooth sequence

Ctrl+W - toggle between B&W and color modes

W - cycle through color, B&W and B&W (toned) modes

Ctrl+1 - select one copy of prints

Ctrl+2 - select two copies of prints

Ctrl+3 - select three copies of prints

Ctrl+4 - select four copies of prints

Ctrl+5 - select five copies of prints

Ctrl+6 - select six copies of prints

Ctrl+7 - select seven copies of prints

Ctrl+8 - select eight copies of prints

Ctrl+9 - select nine copies of prints

Shift+Ctrl+1 - select profile 1

Shift+Ctrl+2 - select profile 2

Shift+Ctrl+3 - select profile 3

Shift+Ctrl+4 - select profile 4

Shift+Ctrl+5 - select profile 5

Shift+Ctrl+6 - select profile 6

Shift+Ctrl+7 - select profile 7

Shift+Ctrl+8 - select profile 8

Shift+CursorLeft - crop live view display (reduce the amount of cropping)
Shift+CursorRight - crop live view display (increase the amount of cropping)

Number pad '+' - increase the number copies of prints (up to a maximum of 9 copies)
Number pad '-' - decrease the number copies of prints (down to a minimum of 1 copy)
Page Up - decrease exposure using exposure compensation in auto exposure modes or ISO in
manual exposure

Page Down - increase exposure using exposure compensation in auto exposure modes or I1SO in
manual exposure

b - cycle through number of copies of prints: 1,2,3,4,5,6,7,8,9,1,2,3...

Video booth keyboard shortcuts:

Ctrl+V - switch from stills photobooth mode to video booth mode

Ctrl+P - switch from video booth mode to stills photobooth mode

Ctrl+S - toggle between video and stills photobooth mode and back again

F4 - start video booth capture sequence in video booth mode or photobooth shooting sequence in stills
mode

F7 - start video booth capture sequence

F8 - switch to video booth mode and start the video booth capture sequence
End - end the video recording now rather than wait for the full duration
Ctrl+F1 - select the camera's user 1 picture style

Ctrl+F2 - select the camera's user 2 picture style

Ctrl+F3 - select the camera's user 3 picture style

Ctrl+F4 - select the camera's standard picture style

Ctrl+F5 - select the camera's portrait picture style

Ctrl+F6 - select the camera's landscape picture style

Ctrl+F7 - select the camera's neutral picture style

Ctrl+F8 - select the camera's faithful picture style

Ctrl+F9 - select the camera's monochrome picture style

S - cycle through available picture styles

A - accept the video and switch from the playback screen to the ready screen
P - play video from the start when in displaying the playback screen

X - reject the video, delete it from the computer and switch from the playback screen to the ready
screen
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Using External Buttons for Photobooth Shooting

This page describes a number of different options for connecting one or more pushbuttons to a PC
and use them to control the photobooth mode shooting mode.

Note: For a simple setup you can use the PC's mouse to control the photobooth by selecting the "Use
mouse left button to start and right button to toggle between B&W and color” option in the photobooth
settings.

StealthSwitch

The StealthSwitch is a robust foot switch which plugs straight into a USB port and makes an ideal
switch for photobooth operation. It is very simple to use: just plug it in to any spare USB port, wait a
few seconds for Windows to recognize it and you're ready to go. In full screen photobooth mode
pressing the StealthSwitch button will start the photobooth sequence - that's all there is to it.

Note: If you have already installed the "desktop cloaking" software that comes with the StealthSwitch
you need to disable it otherwise every time you press the button the photobooth display will be hidden.

Arcade Style Buttons

There are several ways arcade style buttons can be connected to a PC and used to control the
photobooth including the StealthSwitch 3 and the serial port method. The StealthSwitch 3 is simpler to
setup than the serial port method but is a little more expensive. Both the StealthSwitch 3 and the serial
port methods are described in detail below.

StealthSwitch 3

The StealthSwitch 3 is similar to the original StealthSwitch described above but has two important
differences:

1) You can connect external buttons which simply plug into standard 3.5mm sockets (the same as
used by most MP3 players)

2) Each button is programmable allowing it to send any key press or sequence of key presses you like
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StealthSwitch 3 showing the five 3.5mm sockets for connecting external buttons on the front and the

USB port on the side
Please note: The StealthSwitch 3 is functionally identical to the StealthSwitch Il which it replaces.

Instructions to add an arcade style button using the StealthSwitch 3:
These are the components required to add an arcade style button: the button, stereo cable with 3.5mm

jacks and two female spade connectors

1) Cut off the jack plug from one end of the stereo cable and bare the wires
2) Plug the USB cable from the StealthSwitch Il and plug the remaining 3.5mm jack from the stereo

cable into one of the StealthSwitch sockets
3) Run StealthSwitch Configuration Utility and select "Keyboard test mode". When you press the each

button you should see something like this:
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4) Release the switch and identify the correct wires to use from the stereo cable by shorting two of
them together. When the correct pair of wires are shorted together the keyboard test window will show
A B, C,DorE

5) Attach the spade connectors to each of the two wires identified in step 4. Use a crimp tool or solder
them to ensure they are firmly attached

6) Connect the wire to the arcade switch using the spade connectors and press the button to check
that the keyboard test window shows A, B, C, D or E

You should now have an arcade button attached to a cable with a 3.5mm jack plug which looks
something like this:

Finally use the StealthSwitch Configuration Utility to program each of the buttons to send the required
key strokes. The best way to do this is to right click on the required button in the main Configurator
window and select "Macro 1", click on "1st KEY" and type the first key in the macro e.g. function key
F4 to start the photobooth sequence. If the macro has more than one key, e.g. Ctrl+B to select black
and white mode, click on "1st KEY" and press (and release) the Ctrl key then click on "2nd KEY" and
press C. When you've finished press the Program button to program the StealthSwitch 3 (you only
need to do this once - the StealthSwitch 3 will remember the settings and can be used on any
computer). The StealthSwitch 3 is now ready to be used to control the photobooth.

Kensington Wireless Presenter

This provides a simple and effective way for the operator to wirelessly control the photobooth. The
following keyboard shortcuts can be accessed using the Kensington Wireless Presenter:

laser pointer button (F5) - start the photobooth sequence

left arrow (Page Up) - decrease exposure using exposure compensation in auto exposure modes or
ISO in manual exposure

right arrow (Page Down) - increase exposure using exposure compensation in auto exposure modes
or ISO in manual exposure
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stop button (b) - cycle through number of copies of prints: 1,2,3,4,5,6,7,8,9,1,2,3...

Serial Port Method

What you need

1. Unless the PC has a serial port you will need a USB to RS-232 adaptor such as the StarTech.com
USB to RS-232 Serial DB9 Adaptor. This is not the cheapest adaptor available, but it does work on
Windows XP and Windows Vista.

2. DB9 socket and wires or an old RS-232 cable with a DB9 socket

3. A suitable "push to make" button. The arcade style button below was purchased from Gremlin
Solutions in the UK. This site in the US has a good selection of buttons: www.happcontrols.com

4. Photobooth Pushbutton Utility, PhotoboothBtn_DSLR.exe, which can be found in the DSLR Remote
Pro for Windows installation folder
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Connecting it up

First install the driver software that comes with the USB to serial to RS-232 adaptor and connect it to a
USB port on your PC. Then run the Photobooth Pushbutton utility (PhotoboothBtn_DSLR.exe):
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Next identify the correct COM port for the serial port. This can be done by using a small piece of wire
and connecting pins 1 and 4 on the DB9 connector (shown below). If the correct COM port is selected
the "Pin 1" checkbox in the Photobooth Pushbutton utility should be checked when pins 1 and 4 are
connected. If nothing happens try selecting a different COM port from the drop down list.

Now wire up the button or buttons to the appropriate pins on the DB9 socket e.g. if you're using two
buttons pin 4 should be connected to the "common" connections of the two buttons and pin 1 should
be connected to the "push to make" connection of one button and pin 6 to the "push to make"
connection of the other button. Normally the connections would be made by soldering the wires to the
DB9 connector but if you're not happy with soldering you can use an RS-232 cable instead and simply
cut off one end, identify which wires to use and then connect them to the spade connections on the
buttons using crimp connectors.

Once the buttons are connected they can be tested by observing whether the appropriate checkboxes
are checked in the pushbutton utility app when each button is pressed.

Finally, select the required action for each button using the drop down lists in the pushbutton utility e.g.
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for a two button setup with DSLR Remote Pro for Windows where the user can select B&W or color
prints you would use settings similar to those below:

In operation

Connect the USB to RS-232 adaptor to a USB port on the PC and, making sure no buttons are
pressed, run the Photobooth Pushbutton utility. Before running DSLR Remote Pro for Windows check
that the buttons are working properly by pressing them and making sure the correct checkbox in the
pushbutton utility is checked. It may be necessary to select a different COM port if the buttons don't
work. Normally the same COM port is assigned provided the USB to RS-232 adaptor is connected to
the same USB port each time.

Next run DSLR Remote Pro for Windows, select fullscreen photobooth mode and you should be able
to use the buttons to trigger the photobooth sequence. The Photobooth Button utility needs to running
at all times during photobooth operation so that it can detect the button presses and forward them to
DSLR Remote Pro for Windows.

In Operation

In Operation

Once everything is setup simply run DSLR Remote Pro for Windows and press Ctrl+F4 to enter full
screen mode and display the ready screen. You probably don't want to have a keyboard on show
otherwise users will be able to exit the photobooth mode and access your computer. There are a
number of methods that can be used to start the photobooth shooting sequence:

1. The simplest option is to use a mouse and set the start option to "Left click to start, right click to
toggle B&W mode" or one of the other left click options. Provided the keyboard is hidden away the
users won't be able to access your computer but use the left mouse button to start the sequence
and the right mouse button to toggle between B&W and color photos.

2. Alternatively you could use a programmable USB input device which can be setup to send an F4
key press to DSLR Remote Pro for Windows:

a) The Powermate from Griffin Technology (http://www.griffintechnology.com/products/powermate/)
is an inexpensive and nicely made device which works very well.
b) The StealthSwitch (http://www.stealthswitch.com) is a very robust foot switch which simply needs
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to be plugged in to be used in fullscreen photobooth mode. No additional drivers need to be
installed. The desktop hiding software that comes with the StealthSwitch should be disabled
otherwise the photobooth screen will be hidden when the switch is pressed.

3. For a more professional setup you could use external panel mounted buttons.

4. Use a touchscreen and one of the left click start options

If "auto reconnect” is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photobooth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
ready.jpg screen is displayed.

The keyboard shortcuts Ctrl+1, Ctrl+2, Ctrl+3, Ctrl+4, Ctrl+5, Ctrl+6, Ctrl+7, Ctrl+8 or Ctrl+9 can be
used to specify the number of copies of prints when running in full screen photobooth mode. The
number pad "add" and "subtract” keys can also be used to increase or decrease the number of copies.
A small confirmation message is displayed for approximately 2 seconds in the bottom right corner of
the display when the number of copies is changed.

A default profile can be used to reset the photobooth to a known state after each shooting sequence.

To exit fullscreen photobooth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.

Reprints

The last print layout can be reprinted by typing Ctrl+R in full screen photobooth mode. Alternatively
select the output option to also save a JPEG copy and then use a browser or image editor to select
and print the required layout.

XML Shooting Information

After each set of shots an XML file containing information about the set of photos is written to the
folder where the photos are downloaded from the camera. The XML file has the same filename as the
first shot in the sequence (but with a .XML file extension). An example XML shooting information file is
shown below:

<?xml version="1.0" 2>
<breeze systems photobooth version="1.0">
<photo information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user_data>sales@breezesys.com</user_data>
<prints>1</prints>
<photobooth images folder>C:\Photobooth\PhotoboothImages</photobooth images folder>
<photos>
<photo image="1">20110126 163719 1.JPG</photo>
<photo image="2">20110126 163719 2.JPG</photo>
<photo image="3">20110126 163719 3.JPG</photo>
<photo image="4">20110126 163719 4.JPG</photo>
<output>prints\20110126 163719.jpg</output>
</photos>
</photo_information>
</breeze systems_ photobooth>

The <date> and <time> tags contain the date and time of the first shot in the sequence. Please note
that the date and time will only be correct if the camera'’s clock is set correctly. The camera's clock can
be automatically synchronized with the PC's time when it connects to the PC by selecting the
automatic synchronization option in the camera settings dialog.

The <user_data> tag contains the text entered by the user if the touchscreen keyboard option is used.
The <prints> tag contains the number of prints requested (this is O if the user rejects the photos in the
print confirmation window)

The <photobooth_images_folder> tag contains the full pathname of the photo booth images folder.
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The <photo> tags contain the filenames of the photos taken in the shooting sequence.
The <output> tag contains the filename of the JPEG copy of the printed output (if selected).

The writing of the XML shooting information file can be suppressed by setting the following value in the
Windows registry to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothSuppressXml

This can be done by creating a text file named SuppressXML.reg containing the following and then
double clicking on the file in Windows Explorer to copy the information to the registry:

Windows Registry Editor Version 5.00

[HKEY CURRENT USER\Software\BreezeSystems\DSLRRemotePro\100]
"PhotoboothSuppressXml"=dword: 00000001

Please note that this setting will be ignored and the XML will be written if the touchscreen keyboard
option is used.

Using external flash or studio strobes with live view

Due to the way Canon have designed live view on their cameras the triggering of flash guns and studio
strobes can cause problems. Some options for lighting a photobooth are outlined below:

Option 1: Use an E-TTL Il compatible flash connected to the camera's hotshoe. This should work for
all mid to high end cameras. The camera's live view exposure simulation should disabled otherwise
the live view images may be too dark. This doesn't work very well with low end camera models
because they initially disable live view exposure simulation automatically but then turn it back on again
after a few seconds.

Option 2: Use a flash which is not E-TTL Il compatible or studio strobes connected using a hotshoe to
PC cord adapter. This should work for mid to high end camera models if the camera'’s live view silent
shooting setting is disabled and live view exposure simulation is disabled. This will also work for low
end camera models if the "external flash" option in used.

Option 3: Use the camera's built-in flash to trigger the main flash or strobe via a slave unit. This
should work for mid to high end camera models if the camera's built-in flash is set to manual flash not
E-TTL Il. If the flash is set to E-TTL Il the camera fires a pre-flash which will trigger the main lighting
prematurely. The flash mode on low end camera models cannot be changed and is setto E-TTL Il
which means you will always get a pre-flash. However, this method should work with low end camera
models if you use a slave unit which has pre-flash cancellation so that it ignores the pre-flash and only
triggers off the main flash.

Option 4: Use the camera's built-in flash. This should work with all camera models but may result in
result in rather harsh, unflattering lighting.

Option 5: Use continuous lighting or available light to avoid the need for flash. This will work with all
camera models but may cause problems if the available light is too dim or keeps changing.

Mid to high end camera models: 40D, 50D, 60D, 7D, 5D Mark Il, 1D Mark Ill, 1D Mark IV, 1Ds Mark 11|

Low end camera models: 450D/Rebel XSi, 500D/Rebel T1i, 550D/Rebel T2i, 600D/Rebel T3i, 1000D/
Rebel XS, 1100D/Rebel T3

Green Screen Shooting

The photobooth mode in DSLR Remote Pro for Windows v2.0 introduces green screen shooting.
Green screen photography works by taking photos of the subject in front of a green background and
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then automatically replacing the background with a background image. The background image can be
anything you like such as an exotic location, a cityscape or even a photo of the President of the United
States.

DSLR Remote Pro for Windows also supports blue screen shooting. This works in exactly the same
way but uses a blue background instead of a green background. To enable blue screen shooting
select the "Blue screen mode" checkbox when the green screen settings dialog is displayed.

DSLR Remote Pro for Windows will automatically replace the green background with the chosen
background when using live view in photobooth mode and also when using the live view window. This

means that the users will see what the final picture will look like with the new background as opposed
to the green background that the cameras sees.

A basic green screen setup is shown below:

Basic green screen setup with green screened live view images displayed on the monitor

When the images are printed out as a double strip they look like this:
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Live view settings

The green screen setup dialog can be selected by typing Ctrl+G in fullscreen photobooth mode or
when the live view window is displayed:

First select the background image by pressing on the "..." button then click on the checkbox to enable
green screen display (not required in photobooth mode). Then adjust the sliders so that all of the green
screen background is replaced with the background image but the foreground subject is unaffected.
The easiest way to do this is to move the "Green threshold" slider to the left until most of the
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background is replaced and then fine tune the settings by moving the "Red level" and "Blue level"
sliders to the right. The best settings to use will depend on the lighting conditions and the quality of the
green background. If areas of the subject show the background the settings are too strong and should
be reduced by moving the red and blue sliders to the left of the green slider to the right.

For best results the avoid green background should be evenly lit and the subject should be positioned
to minimize shadows falling on the background.

Green Screen Backgrounds and Overlays in Photobooth Mode

In fullscreen photobooth mode the greenscreen settings dialog appears as shown below:

Select the "Save copy of greenscreened photos in photo booth mode" option to save a of the photo
downloaded from the camera with the green background replaced with the background image. The
greenscreened copies are saved the "greenscreen" subfolder of the folder where the images from the
camera are saved.

In fullscreen photobooth mode the green screen background and overlay images are loaded from the
photobooth images folder. The background image should be named greenscreen_background.jpg and
the overlay image should be named greenscreen_overlay.png. Different overlays and backgrounds
can be used for each shot by appending the shot number to the filenames e.g.

Shot 1: background filename: greenscreen_background_1.jpg, overlay filename:
greenscreen_overlay_1.png

Shot 2: background filename: greenscreen_background_2.jpg, overlay filename:
greenscreen_overlay_2.png

Shot 3: background filename: greenscreen_background_3.jpg, overlay filename:
greenscreen_overlay_3.png

Shot 4: background filename: greenscreen_background_4.jpg, overlay filename:
greenscreen_overlay_4.png

Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
shortcut keys.

Printing the Images
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There are two methods to print out the green screened shots:

Method 1: DSLR Remote Pro for Windows takes the photos, performs the green screen removal and
prints the images. DSLR Remote Pro for Windows can perform simple green screen removal and print
the images without the need for any other software. This is simple to setup and is fine for small
photobooth prints under good lighting conditions. When green screen is enabled DSLR Remote Pro for
Windows will automatically replace the green background with the background image when printing
out the photobooth images unless the photobooth output option is set to "None".

This method doesn't require any software other than DSLR Remote Pro for Windows

Method 2: DSLR Remote Pro for Windows takes the photos and saves them in a folder where another
specialist green screen application replaces the background and passes the images to Hotfolder Prints
for formatting and printing. This is more complicated to setup than method 1 but by using a specialist
green screen application it will give superior results which are more suitable for larger prints.

This method requires DSLR Remote Pro for Windows v2.0 or later plus a green screen application
such as Green Screen Wizard Pro Batch and Hotfolder Prints.

When using method 2, green screen printing in DSLR Remote Pro for Windows can be disabled by
setting the output option to "None" in the photobooth settings page. DSLR Remote Pro for Windows
will run the fullscreen photobooth complete with green screened live view images and save the photos
to the folder specified in preferences e.g. to save the images in the folder C:\Photobooth the
preferences should be set to:
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DSLR Remote Pro for Windows preference settings to save the images in C:\Photobooth

The green screen app should be setup to monitor the folder where the photos are saved, automatically
replace the green background with the selected image and save them in a separate folder. The
settings for Green Screen Wizard Pro Batch to monitor photos in C:\Photobooth and save the green
screened images in C:\Photobooth\GreenScreen would be:
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Green Screen Wizard Pro Settings (click on Tools in the main window to display the settings)

Please see the Green Screen Wizard website for information about Green Screen Wizard Pro Batch
and to purchase a copy. Please make sure you purchase the Green Screen Wizard Pro Batch version
as this is the only version which can monitor a folder for new photos and automatically replace the
green background.

Important: To ensure that what the user sees in DSLR Remote Pro for Windows' live view display and
the final printed output is the same the green screen background image should have an aspect ratio of
3:2. If a different aspect ratio is used the alignment of the background image may be different in the
live view display and the green screened prints. If the images are to printed on 6"x4" paper at 300 dpi
the background image should be a JPEG which is 1800 pixels wide by 1200 pixels high.

The green screen application will have its own settings for optimizing the green screen removal and
will need to be setup separately. The settings used in DSLR Remote Pro for Windows' live view display
will only affect what the user sees, not the final prints when using a separate app to perform the green
screen removal.

Hotfolder Prints should then be setup to monitor the folder where the green screened images are
saved so that it can automatically format and print them as required. The Hotfolder Prints preferences
screen to monitor C:\Photobooth\GreenScreen for four new images and then automatically format and
print them would be:
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9.8 Live View Overlay
Photo Booth Mode

An optional overlay image can be displayed over the live view images in fullscreen photobooth mode to
add fun effects such as superimposing a body builder's body with the user's head. It can also be used
to create fancy borders for the live view images to give the booth a more custom feel.

The overlay image should be a PNG file with transparency information in the alpha channel. It should
be in landscape orientation with an aspect ratio of 3:2 e.g. 1056x704 pixels in size. If the aspect ratio
of the overlay image isn't the same as the live view images it will be stretched to fit and may appear
distorted.

The overlay file should be named live_view_overlay.png and saved in the photobooth images folder.

Please note: The live view overlay image only affects the live view images displayed to the user and
won't appear in the printed output. To overlay the images in the printed output create a copy of the
live_view_overlay.png file called image_overlay.png and save it in the the photobooth images folder.
Overlays can also be used in conjunction with green screen shooting to provide effects such as
foregrounds or overlays to mock up a magazine cover.

9.9 How to create PNG images using Photoshop

Photoshop
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9.10

First create a new image with a transparent background. Then create a mask by clicking on the "Add
layer mask" in the layers palette.

Next add the graphics such as text overlays and picture frames to the image layer and use the layer
mask to control the transparency. In the layer mask white represents opaque, black represents fully
transparent and values between white and black represent increasing transparency.

Save a copy of the image as a PSD file for future reference and then save the image as a PNG file
named overlay.png.

Photoshop Elements

First create a new image with a transparent background. Next add the graphics such as text overlays
and picture frames and use the opacity slider for the layers to control opacity. To get a simple fade
effect, you can also use the gradient tool. Once you're happy with your image, save a copy as a PSD
file for future reference and then save the image as a PNG file named overlay.png.

Videobooth shooting

A video booth is similar to a photobooth except instead of taking one or more stills pictures it captures
a short video clip. Video booth shooting is available with all Canon DSLR cameras that support movie
mode except for the Canon Digital Rebel T1LI/EOS 500D. The cameras can only capture video to the
camera's memory card and so the camera must have a memory card with sufficient space in order to
use the video booth mode (video files are automatically downloaded to the PC and deleted from the
memory card after capture).

Overview

The video booth mode works in a similar way to photobooth mode. Users are presented with a ready
screen with a live view display showing what the camera sees. When the user presses the start button
a countdown screen is displayed together with countdown message. At the end of the countdown the
capture screen is displayed together with a progress bar that shows how much time is remaining. After
the video clip has been captured the processing screen is displayed and the movie file is automatically
downloaded from the camera's memory card to the PC and then deleted from the memory card to
make space for the next clip. After downloading the ready screen is displayed ready for the next video
capture.

Video Booth Settings

The dialog below is displayed when "Video booth settings..." is selected from the File menu:
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In order to use the video booth mode it must be enabled by selecting "Enable video in photobooth
mode". Normally when you enter fullscreen photobooth mode (by typing Ctrl+F4) the photobooth ready
screen will be displayed. If you wish to startup in video booth mode select the "Startup in video booth
mode when selecting full screen photobooth" checkbox.

Select the "Display playback screen after capturing video" to allow users to play back the video and
decide whether to accept it or reject it. The playback screen will be displayed until the user either
accepts or rejects the video. When the video is rejected it is automatically deleted from the computer.
When the "Start playback automatically" option is selected video playback will start automatically when
the playback screen is displayed.

Use the "Duration of captured video clip" setting to specify the duration of the video clip in seconds.
This can be any value up to 120 seconds (2 minutes).

Use the "Countdown before capturing video" setting to specify the length of the countdown before
video capture starts. The countdown text is displayed during the countdown and is updated every
second. The following tokens can be used:

@videoClipLength@ - the duration of the video clip in seconds

@videoCountdown@ - the number of seconds remaining before video capture starts

Use the "..." buttons after the font and font color displays to change the font and color of the
countdown text.
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The size and position of the video playback window can be set manually or set automatically by the
program. If the height is set to 0 the program will automatically display the video playback at the same
resolution as capture, or if this is to big to fit on the screen it will scale the size down to fit the screen.
The video playback window is normally displayed at the top of the screen but can be moved down
using the top offset setting if required. The video playback window left offset allows the horizontal
position of the window to be specified. The default setting of -1 will center the video playback window
on the screen.

Use the "..." buttons after the record/playback progress bar foreground and background color displays
to change the colors of the progress bar displayed during recording and playback.

Note: the progress bar can be hidden by setting the foreground and background colors to the same
values.

The size and position of the live view display uses the same settings as the stills photobooth and can
be specified using the photobooth settings dialog. The various screens used by the video booth should
be saved in the photobooth images folder which can also be specified using the photobooth settings
dialog. Click on the "Photobooth Settings..." button to save the current video booth settings and display
the photobooth settings dialog.

Images displayed to the user
The following screen images are displayed to the user at different stages of the video capture:

video_ready.jpg - displayed when the video booth is ready to capture the next clip
video_countdown.jpg - displayed together with the countdown text during the countdown before
capturing the clip

video_capture.jpg - displayed together with a progress bar while the video clip is being captured
video_processing.jpg - displayed after video capture while the movie file is being transferred to the PC
video_playback.jpg - displayed when playing back the video that has just been captured
video_playback_finished.jpg - optional screen image displayed after playback or after downloading the
video if auto playback is not enabled

The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.

Audio prompts can be added by placing a WAV sound file in the photobooth images folder and giving it
the same name as prompt screen. For example to play a sound when the video booth is ready copy a
WAV file named video_ready.wav into the photobooth images folder and it will be played when the
video_ready.jpg image is displayed.

In Operation

Once everything is setup simply run DSLR Remote Pro for Windows and press Ctrl+F4 to enter full
screen mode and display the ready screen. If the "Startup in video booth mode when selecting full
screen photobooth" is not set the window will start in photobooth mode. You can switch from
photobooth mode to video booth mode by typing Ctrl+V and from video booth mode back to
photobooth mode by typing Ctrl+P. In video booth mode press F7 to start the video capture sequence.
The user can then press the "End" key to stop the recording or wait until it reaches the duration setting
and stops automatically.

When the video playback screen is displayed the user can type P to play the video, A to accept it or X
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to reject it. Please see keyboard shortcuts for a complete list of keyboard shortcuts.

The user must either accept or reject the video before the booth will return to the ready screen. When
the user rejects the video to movie file is deleted and is not saved on the camera's memory card or the
PC's hard disk. There is a default timeout of 300 secs after which time the video will be automatically
accepted. This timeout is stored in the Windows registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\VideoboothPlaybackTimeout

If "auto reconnect” is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photobooth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
ready screen is displayed.

To exit fullscreen photobooth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.

10  Automatic Printing of Photos

Photobooth mode can also be used for automatically printing out photographs as they are taken.
When this is setup you can take a picture with the camera using the normal camera controls and it will
be automatically downloaded to the PC and printed out using the current photobooth layout settings.
An optional confirmation screen can also be displayed allowing the photographer to decide whether to
print each photo. Applications include school and portrait photography, Santa's Grotto shots and id
photographs.

To use this mode set the number of photos in photobooth mode to 1, design the print layout (e.g. set
the number of rows and columns to 1, add headers, footers, captions and overlays as required) and
then select fullscreen photobooth mode. Then simply take each photo and it will be downloaded to the
PC and printed automatically. If the option to ask for confirmation before printing is selected the display
will show a print preview and ask for confirmation before printing each shot. Reprints of the last shot
can be made by typing Ctrl+R.

11 Running DSLR Remote Pro from other apps

Overview

DSLR Remote Pro for Windows includes an interface library called DSLRRemoteLib.dll which can be
used by other applications to control DSLR Remote Pro for Windows. Also included is a simple
command line application called DSLRRemoteTest.exe which can be used to control DSLR Remote
Pro for Windows from a command prompt or a batch file. For example a batch file could be written to
take a series of photos using different apertures and shutter speeds to bracket the exposure.

DSLRRemoteLib.dll

DSLRRemoteLib.dll is a library that can be used by other programs to control DSLR Remote Pro for
Windows. It can be found in the main folder where DSLR Remote Pro for Windows is installed (usually
C:\Program Files\BreezeSys\DSLR Remote Pro). Please see the DSLRRemoteTest\ReadMe.txt and
DSLRRemoteLib.h files for details.

Files included:
DSLRRemoteTest.exe - compiled console application

DSLRRemoteLib.dll - DLL used by DSLRRemoteTest.exe to interface with DSLR Remote Pro for
Windows
DSLRRemotelLib.lib - lib for C++ apps to link to the DLL
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DSLRRemoteLib.h - header file for C++ applications using the DLL

DSLRRemoteTest - directory containing a VC++ project and source code for DSLRRemoteTest.exe

DSLRRemoteTest.exe

DSLRRemoteTest.exe is a simple command line application that communicates with DSLR Remote
Pro for Windows and allows the shutter to be released and some of the camera settings to be
changed. DSLRRemoteTest.exe and complete source code to build it using Visual C++ .Net can be
found in the DSLRRemoteTest folder where DSLR Remote Pro for Windows is installed (usually C:
\Program Files\BreezeSys\DSLR Remote Pro).

To run DSLRRemoteTest.exe first run DSLR Remote Pro and then open a command prompt window
and change directory to the DSLR Remote Pro for Windows installation folder. The run
DSLRRemoteTest.exe -h to get a list of the available commands.

Here is the output from a simple session where the output directory is set and the shutter is released
(commands typed in by the user are shown in bold):

Microsoft Windows XP [Version 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

C:\>cd C:\Program Files\BreezeSys\DSLR Remote Pro

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe -h

Usage: DSLRRemoteTest [-w [<shots>] [-1 <interval>]] [-a <aperture>] [-s
<shutter>]

-h print this usage information

-w <shots> run camera as a webcam for <shots> shots

images are saved as webcam.jpg in the current

directory

-t <interval> specify the number of seconds between shots when

used as a webcam

-3 <camera#> select camera (multi-camera versions of DSLR Remote
Pro only)

-C <connect> connect or disconnect from the camera

-a <aperture> set the aperture, 0 = widest aperture

-b <WB> set the white balance or kelvin color temp

-e <mode> set the exposure mode (1D series cameras only)

-s <shutter> set the shutter speed, 0 = longest shutter speed

-x <comp> set the exposure compensation

-1 <quality> set the image size and quality

-I <ISO> set the ISO

-c <comment> set comment to be added to images (max 255 chars)

-p <prefix> set the filename prefix (max 255 chars)

-0 <directory> set the output directory

-q query output directory

-n don't release shutter

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe -n -o C:
\Photos -q
Output directory: C:\Photos\2007-01-15\

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe
Success, image saved as: C:\Photos\2007-01-15\IMG 0001.JPG

C:\Program Files\BreezeSys\DSLR Remote Pro>
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12 Preferences

Click on "File->Preferences" to display the preferences dialog.

Mouse Button Actions

The middle and right mouse buttons can be assigned to release the shutter or take pictures in preview
mode. This allows you to use the mouse like a simple cable release.

Note: This only works if the mouse pointer is over the main window and is not over one of the controls.

New vs Old Canon libraries for 20D, 350D, 5D, 1D2 and 1DS2

Canon supply two different sets of libraries for controlling the EOS 20D, 350D, 5D, 1D Mark Il and 1DS
Mark Il. The newer libraries are more reliable than the old libraries but don't offer as much control for
some camera models from the PC. For example you can set the focus points and the AF mode from
the PC with the Canon EOS 20D using the old libraries but not with the new libraries.

We recommend using the newer libraries for most cameras. If you have a 20D it is worth trying the old
libraries, but if you have problems with the camera locking up with "busy" flashing on its LCD you may
need to use the newer libraries.

If the camera is connected when this setting is changed you will need to disconnect and reconnect for
the setting to take affect.

On Windows Vista and Windows 7 only the new Canon libraries can be used and so this option will be
selected automatically.
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Preview Images

The default setting when taking preview shots is to switch to small JPEG images to reduce the file size
and speed up the download time. Recent cameras have much faster USB 2.0 interfaces and can
download images much faster making download speed less of an issue. When "Use small JPEGs for
preview shots" is not selected DSLR Remote Pro for Windows will use the current image size and
quality when takinh preview shots.

(This option is ignored when using the original EOS-1D or EOS-1Ds cameras).

Delete Movie Files

Movies files are stored on the camera’'s memory card and have to be separately downloaded to the
PC. When the "Delete movie files from memory card after downloading to PC" option is selected
movie files will be automatically deleted from the camera's memory card after they have been
successfully downloaded to the PC to free up space on the memory card. Please see the section on
video capture for more information.

Specifying the output directory

These settings control where images are stored on the computer's hard disk. The edit box displays the
base directory for images and can be changed by typing directly into the edit box or by clicking on the
"..." button and using the directory browser. If the Year, Month and Day checkboxes are not checked
this will be the directory in which all images are stored.

Note: If the directory does not already exist it will be created when the photo is saved.

The Year, Month and Day checkbox control the automatic generation of subdirectories according to
the computer's date. The example image name shown at the bottom of the dialog shows how the
various settings are combined. Select the "Flatten date" checkbox to combine the year, month and day
into a single subdirectory e.g. in the example above:

January 14, 2009 with "Flatten date" unchecked gives "C:\DSLRRemote\2009\01\14"

With "Flatten date" checked it gives "C:\DSLRRemote\2009-01-14"
You can also use the IPTC tokens to when specifying the output directory e.g. "C:\%Y\%T" would give
the year followed by the camera model.

Image Filenames

When "Use camera filenames" is selected DSLR Remote Pro for Windows uses the same filenames
for images saved to the PC as the camera uses for images saved to its memory card (when the option
to save images to camera and PC is used). If the option to save images to the PC only is used the
filenames from the camera will start from 0001 each time the camera is connected e.g. IMG_0001.
CR2, IMG_0002.CR2 etc. To avoid overwriting existing files DSLR Remote Pro for windows will
automatically add a number to the end of the filename e.g. IMG_0001_1.CR2. The sequential file
numbering and append sequence letter to filenames when auto-bracketing options are ignored when
camera filenames are used.

Note: Camera filenames are not available with older cameras (i.e. camera which don't use the CR2
raw file format).

By default image filenames are in upper case e.g. IMG_0001.JPG or IMG_0001.CR2. If the "Lower
case file extensions" checkbox is selected images will be saved with lower case file extensions e.g.
IMG_0001.jpg or IMG_0001.cr2.

When the "Sequential file numbering" checkbox is set DSLR Remote Pro for Windows stores images
using a numeric sequence number when they are saved to the PC's hard disk. It scans the output
directory for existing images and uses the lowest available sequence number e.g. if the output
directory already contains the image 0123.JPG DSLR Remote Pro for Windows will save the next
image as 0124.JPG. DSLR Remote Pro for Windows will then continue numbering from that point
even if the images are removed from the directory while it is running. This is to prevent duplicate
filenames when images captured by DSLR Remote Pro for Windows are immediately removed from
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the output directory e.g. when using a program to automatically send the images to a picture desk
using FTP.

When the "Sequential file numbering” checkbox is not set DSLR Remote Pro for Windows scans the
output directory for existing images and uses the lowest available number to give a unique filename e.
g. if the output directory already contains the image 0123.JPG DSLR Remote Pro for Windows will
save the next image as 0124.JPG.

You can also use the IPTC tokens to when specifying the output directory e.g. "C:\%Y\%T" would give
the year followed by the camera model.

When "Append sequence letter to end of filenames when auto-bracketing” is selected auto-bracketed
filenames have the same image number and a sequence letter added to each shot for easy
identification. e.g. a 3-shot sequence might give filenames 0001a.JPG, 0001b.JPG and 0001c.JPG as
opposed to 0001.JPG, 0002.JPG and 0003.JPG when this option is switched off.

Select the "use camera filenames" option if you want DSLR Remote Pro for Windows to use the same
names for images saved to the PC as those saved to the camera's memory card. Please note that
camera filenames may not be available with older camera models.

JPEG images are saved with a .JPG file extension e.g. 0001.JPG, 0002.JPG etc.

Raw images from current EOS cameras are saved with a .CR2 file extension. If raw+JPEG mode is
selected the JPEG image will be saved as the same filename as the raw file but with a .JPG file
extension e.g. 0001.CR2 and 0001.JPG.

Raw files from older EOS cameras (e.g. Canon EOS 10D) are saved as two files: the CRW file
containing the raw image data and the THM file containing a small JPEG thumbnail image. Raw
images are saved as: 0001.CRW and 0001.THM, 0002.CRW and 0002.THM, 0003.CRW and 0003.
THM etc.

Raw images from the EOS-1D and EOS-1DS are saved with a .TIF file extension. If raw+JPEG mode
is selected the JPEG image will be saved as the same filename as the raw file but with a .JPG file
extension e.g. 0001.TIF and 0001.JPG.

You can specify an optional prefix to be added at the start of each image's filename e.g. the prefix
"studio shoot " would result filenames like "studio shoot 0001.JPG", "studio shoot 0002.CR2" etc.

The number of digits used in the filenames can be specified from 0 to 10. When this is set to 1 or more
the filenames will always contain a humber and this will be padded with leading zeroes if required. If it
is set to 0 and a filename prefix is defined the filename will use the prefix unless the file already exists
in which case it will add _ followed by the lowest available number to make the filename unique.
Please note that setting the number of digits to 0 may not number raw and JPEG images correctly
when shooting RAW+JPEG.

Example 1: Filename prefix: IMG, number of digits: O
Images will be saved with the following names: IMG.JPG, IMG_1.JPG, IMG_2.JPG... IMG_10.JPG

Example 2: Filename prefix: IMG, number of digits: 1
Images will be saved with the following names: IMG1.JPG, IMG2.JPG, IMG3.JPG... IMG10.JPG

Example 3: Filename prefix: IMG_, number of digits: 4
Images will be saved with the following names: IMG_0001.JPG, IMG_0002.JPG, IMG_0003.JPG...
IMG_0010.JPG

© 2012 Breeze Systems Ltd



78

13

Tokens

Date and time tokens

%a Abbreviated weekday name e.g. Fri

%A Full weekday name e.g. Friday

%b Abbreviated month name e.g. Jun

%B Full month name e.g. June

%d Date in the form YYMMDD (equivalent to %y%m |e.g. 110617 for June
0 %D) 17,2011

%D Day of the month (01 to 31)

%H Hour (00 to 23)

%I Hour (01 to 12)

%)j Day of the year (001 to 366)

%l Long date/time representation of locale i%g.zl\ggridlegbégz?ary

%L Long date representation for locale i%g.zhgﬂday, January

%m Month (01 to 12) e.g. 06 for June

%M Minutes (00 to 59)

%p am/pm indicator e.g. PM

%S Seconds (00 to 59)

o Time in the form HHMMSS (equivalent to %H%M

ot %S)

%W Week number (00 to 53)

%X Date representation for locale 5'79'20061—117—11 for June

%X Time representation for locale e.g.14 39 29

%y Year without century eg. 11

%Y Year with century e.g. 2011

%z Time zone name .?.I?n eGMT Standard

%Z Time zone offset wrt UTC gugn n;og)%onor GMT

%1 Year 'now' in the form YYYY e.g. 2011

%2 Month 'now' (01 to 12)

%3 Day 'now' (01 to 31)

Shooting data tokens

%cC

Camera serial number (Canon EOS cameras
only)
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%C

%e

%i
{orientation}

{orientationAngle}
%0
%0

%T

%T1
%T2
%T3
%T4

%T5

%T6

%V

%V

Other tokens

{comment}

{photoboothNumImages

}
{photoboothimage}

{photoboothDateTime}

{photoboothDate}
{photoboothTime}

{photoboothDir}

{photoboothSubdir}

{imageCounter}

Canon EOS-1D/1DS style camera serial number
File extension (without the '.")

ISO value read from the shooting data

Image orientation: L for landscape or P for
portrait

Image orientation angle in degrees: 0, 90 or 270
Image filename without extension

Owner string (Canon cameras only)

Camera model name starting from the first word
containing digits

Same as %T, but '-' are treated as spaces

Full camera model name

First word of camera model name containing
digits

Same as %T3, but - are treated as spaces
Last word of camera model name containing
digits

Same as %T5, but '-' are treated as spaces
Camera model name starting from the first word

containing digits
(same as %T)

Full camera model name (same as %T2)

The value of comment entered in the main
window

Number of shots defined in photobooth mode

Shot number in photobooth shooting sequence

Date and time at the start of the current
photobooth shooting sequence

Date at the start of the current photobooth
shooting sequence

Time at the start of the current photobooth
shooting sequence

The value of the full pathname of the photobooth
images folder

The value of the photobooth images subfolder

Shutter activation count (the total number of

e.g. JPG for IMG_4567.
JPG

e.g. IMG_4567

e.g. 60D for Canon
EOS 60D

e.g. 1DS for Canon
EOS-1DS

e.g. Canon EOS 60D

e.g. 60D for Canon
EOS 60D

e.g. 60D for Canon
EOS 60D

e.g. 1DS for Canon
EOS-1DS

eg. 4
e.g. first photo returns 1
e.g. 20110126_190509

e.g. Jan 26, 2011
returns 20110126

e.g. 7:05:09 pm returns
190509

e.g. C:
\Photobooth\Profilel

e.g. C:
\Photobooth\Profile1
gives Profilel

e.g. 1234
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pictures that have been taken with the camera)

Same as {imageCounter} but padded with leading

{imageCounters} zeroes to give a 5 digit number

e.g. 01234

Same as {imageCounter} but padded with leading

{imageCounter6} zeroes to give a 5 digit number

e.g. 001234
Filename of the saved print layout in photobooth

{filename} mode (only available for captions used in
photobooth prints)

[****]
Sample Timings

The tables below show approximate timings for the minimum interval between photographs when
triggering the shutter from the PC. The timings approximate and are for guidance only.

Canon EOS 5D

Save to PC and

Size/Quality Save to PC only Save to camera only camera
Raw only 3.5 2.2 4.2
Large/fine 2.5 2 3
Small/normal 2 2 2.2

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate (3 frames/sec) until its buffers become full. After an initial camera processing delay the
images will be transferred to the PC at approximately 3 Mb/sec. The camera is able to continue taking
photos at a reduced frame rate until its secondary buffers become full and then has to wait for images
to be downloaded before taking more photos.

Canon EOS 20D, 30D, 400D/Rebel XTi and 350D/Rebel XT

Save to PC and

Size/Quality Save to PC only Save to camera only ST
Raw only 2.6 2.5 2.6
Large/fine 2.1 2 2.1
Small/normal 2 2 2

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate (5 frames/sec for the 20D and 30D and 3 frames/sec for the 400D/Rebel XTi and 350D/
Rebel XT) until its buffers become full. After an initial camera processing delay the images will be
transferred to the PC at approximately 3 Mb/sec. The camera is able to continue taking photos at a
reduced frame rate until its secondary buffers become full and then has to wait for images to be
downloaded before taking more photos.

Canon EOS-1D Mark Il

Save to PC and
camera

Raw 3.8 3 4.5

Size/Quality Save to PC only Save to camera only
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Large/fine 2.3 2.7 3.1
Small/normal 2 2.4

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate (8 frames/sec) until its buffers become full. After an initial camera processing delay the
images will be transferred to the PC at approximately 2.5 Mb/sec. The camera is able to continue
taking photos at a reduced frame rate until its secondary buffers become full and then has to wait for
images to be downloaded before taking more photos.

If the EOS-1D Mark Il is set to continuous, high speed drive mode and the pictures are taken using the
camera's shutter release (as opposed to triggering the shutter from the PC) it can sustain a shooting
rate of approximately 3 frames/sec indefinitely when shooting in small/fine JPEG or large/normal
JPEG.

Canon EOS-1D
Save to PC and

Size/Quality Save to PC only Save to camera only camera
Raw 3 15 2
Large/fine 3 15 3
Small/normal 2 15 3

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate until its buffers become full. After an initial camera processing delay the images will be
transferred to the PC at approximately 1.5 Mb/sec. The camera is able to continue taking photos at a
reduced frame rate until its secondary buffers become full and then has to wait for images to be
downloaded before taking more photos.

If the EOS-1D is set to continuous, high speed drive mode and the pictures are taken using the
camera's shutter release (as opposed to triggering the shutter from the PC) it can sustain a shooting
rate of approximately 3 frames/sec indefinitely when shooting in small/fine JPEG or large/normal
JPEG.

Canon EOS 10D
Save to PC and

Size/Quiality Save to PC only Save to camera only SR
Raw 35 8 41
Large/fine 14 S 17
Medium/fine 4 11
Small/fine 4

Small/normal 4 4

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate until its buffers become full. After an initial camera processing delay the images will be
transferred to the PC at approximately 0.25 Mb/sec. The camera is able to continue taking photos at a
reduced frame rate until its secondary buffers become full and then has to wait for images to be
downloaded before taking more photos.

Please note: The above timings were performed using a Canon EOS 10D with firmware version 1.0.0.
The timings with firmware version 2.0.1 are approximately 50% longer.

Canon EOS 300D Digital/Kiss Digital/Digital Rebel

Save to PC and

Size/Quiality Save to PC only Save to camera only ST
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15

Raw 57 8 55
Large/fine 19 4 20
Medium/fine 10 4 11
Small/fine 4
Small/normal 5 3

When taking photos using the camera's shutter release the camera can take photos at its normal
frame rate until its buffers become full. After an initial camera processing delay the images will be
transferred to the PC at approximately 0.18 Mb/sec. The camera is able to continue taking photos at a
reduced frame rate until its secondary buffers become full and then has to wait for images to be
downloaded before taking more photos.

Release History

12 January 2012: v2.3.1.1
¢ Fixed a crash in v2.3.1 when not shooting in photo booth mode

11 January 2012: v2.3.1

o Added timeouts in photobooth mode for print confirmation, touchscreen keyboard input and video
confirmation

o Displays optional reprinting,jpg screen image and skips the print confirmation screen when reprinting
photobooth images

o Added optional checkboxes to the touchscreen keyboard in photobooth mode

o Added monochrome tint/toning option to support printing in sepia and other tints in photobooth mode

¢ Improved noise reduction in photobooth live preview when displaying black and white images

30 September 2011: v2.3

Added the ability to specify the size and position of the playback window in video booth mode

¢ Now displays the video_playback_finished.jpg screen image, if defined, after video playback

o Added the ability to specify a horizontal offset for the live view display in photobooth mode

¢ Added the option to use {photoboothSubDir} or {photoboothDir} tokens when specifying the profile
pathname to allow the use of more than 8 photobooth profiles

Added a separate delay for the first photo in the stills photobooth shooting sequence

Added optional color management of printed images

Fixed a problem with photobooth shooting using external flash mode when "Only display live view
images for the first shot" is selected

Fixed a problem with incomplete screen refreshes when switching photobooth profiles

3 August 2011: v2.2.3.1

¢ Increased the number of photobooth profiles that can be loaded via keyboard shortcuts/touchscreen
actions from 6 to 8

¢ Fixed a problem selecting B&W mode in DSLR Remote Pro for Windows v2.2.3

26 July 2011: v2.2.3

o Added preset layouts when using the custom layout option to help design popular layouts using four
photos

¢ Added the ability to set the exposure mode from the PC with the following camera models: EOS
500D/Rebel T1i, EOS 550D/Rebel T2i, EOS 1000D/Rebel XS, EOS 40D, EOS 50D, EOS 7D, EOS
5D Mark Il

o Fixed a problem with the default photobooth profile not being applied when shooting in video booth
mode
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23 May 2011:v2.2.2.1

Fixed a problem caused by the latest Canon SDK which resulted in some cameras getting stuck in

manual focus mode

Fixed an error when auto-bracketing with Canon EOS 400D and saving images to the camera only

In fullscreen photobooth mode preview images will now show the image_overlay.png overlay image
(if defined) not live_view_overlay.png

Added extra checks for touchscreen actions to make sure they are not applied at the wrong time in

photobooth mode

4 May 2011:v2.2.2

Added blue screen shooting

Added default profile option to reset the photobooth to a known state after each shooting sequence
Enhanced touchscreen keyboard in photobooth mode to allow multiple input fields and the use of a
normal keyboard

31 March 2011: v2.2.1

Added support for the Canon Rebel T3i (aka Canon EOS 600D) and Canon Rebel T3 (aka Canon
EOS 1100D)

"External flash mode" option in photobooth mode now adjusts live view brightness automatically
when used with Rebel series cameras

Video booth record/playback progress bar now has user definable foreground and background
colors

Users can now stop the video recording by pressing the 'End' key instead of waiting for the preset
time

Now displays a warning instead of an error if touchscreen areas overlap e.g. to allow video booth
related touchscreen buttons to be put in the same place as stills related buttons

Added the ability to run external commands when the photobooth screen changes and when the
XML summary file is written at the end of the photobooth shooting sequence

8 February 2011: v2.2

Added confirm_printing.jpg and printing_confirmed.jpg screens when using the print confirmation
option in photo booth mode

Added an "external flash" mode when photo booth shooting to allow the studio strobes and external
flash guns that are not E-TTL compatible to be used with Rebel series cameras

Added optional touchscreen keyboard in photo booth mode

Green screen shooting in full screen photo booth mode now has the ability to use different
backgrounds and overlays for each shot and to save a green screened copy of each photo

Fixed a problem with time lapse shooting using raw+JPEG mode and the latest camera models

1 December 2010: v2.1.1
o Fixed a problem with keyboard input focus in video booth mode

Fixed a problem switching between video booth mode and photobooth mode with the Canon EOS
60D

Added photobooth keyboard shortcuts and touchscreen actions for selecting camera PictureStyles

10 November 2010: v2.1

Added support for the Canon EOS 60D
Added video booth mode

Photobooth mode now has the option to specify the vertical positioning of the live view display and
countdown text

Photobooth mode now has the option to disable live view during printing

Photobooth previews are now green screened and look like the final output when green screen
shooting

The camera battery status is now displayed in the main window title bar
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e Added an option in preferences to use lower case file extensions for images saved to the PC

27 August 2010: v2.0

o Live view is now automatically restarted if it is canceled by the camera

o Added support for motion detection using Webcam Zone Trigger (available separately from http://
Www.zonetrigger.com)

o Added green screen shooting overlay in main live view window and in photobooth mode

o Added optional overlay image for live view display in photobooth mode

¢ Photobooth timings changed so that countdown text now counts down to 1 instead of stopping at 2

24 May 2010: v1.9.1

o Fixed a problem with B&W images being printed in color in the custom photobooth layout

¢ Improved handling of external button presses in photobooth mode to prevent a new shooting
sequence from being started before the current one has finished printing

o Added the ability to turn off the AF area rectangle in live view (by typing Ctrl+TAB)

11 May 2010: v1.9

Added the following enhancements to photobooth shooting:

¢ New, more flexible custom layout of prints including image rotation. Please note that custom layouts
from previous versions of DSLR Remote Pro for Windows will need to be updated if they use the
"Copy left half of page to right to create a double strip" option

e Captions can now be rotated

¢ Live view is hidden when displaying the release.jpg image to avoid confusion caused by the live view
freezing just before the picture is taken

e Added an optional minimum duration before closing the processing.jpg screen to allow a 'Please
leave the booth now' message to be displayed for several seconds at the end of the sequence

o The default behavior of the live view inactivity timer now disables and immediately re-enables live
view after 25 minutes to avoid the camera cancelling live view after 30 minutes

31 March 2010: v1.8.3

o Added preliminary support for video capture with the Canon EOS 5D Mark Il, Canon EOS 7D,
Canon EOS 1D Mark IV, Canon EOS 500D/Rebel T1i and Canon EOS 550D/Rebel T2i

¢ Fixed a problem which caused live view images to be displayed on top of preview images in
fullscreen photobooth mode.

¢ Fixed a problem shooting to the camera's memory card only when using the Canon EOS 550D/
Rebel T2i and Canon EOS 5D Mark I

March 2010: v1.8.2

Added support for Canon EOS 550D/Rebel T2i

Full +/-5 EV exposure compensation range now available with cameras that support it

Added "Remote Manual" AF option for taking photos from the PC without using auto-focus
Added an inactivity timer for live view in fullscreen photobooth mode

The camera's LCD can now be turned on and off remotely from the PC when live view is active
(recent cameras with HDMI outputs only)

¢ Fixed a problem selecting 30 sec shutter speed when auto-bracketing with cameras that have a
separate bulb setting on the exposure mode dial

e o o o o (U

27 January 2010: v1.8.1

o Added support for the Canon EOS-1D Mark IV

e Added workaround for Canon EOS 50D firmware bug which causes camera controls to be locked
with "busy" displayed on the camera LCD after using live view

o Added the ability to specify the number of digits in filenames

o Added optional live view overlay image

¢ Fixed problems with bulb shooting from the PC when using the Canon EOS 7D
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o Fixed a reliability problem when shooting long continuous sequences at high frame rates

11 December 2009: v1.8

o Added support for the Canon EOS 7D

e Added an option to automatically edit JPEGs and raw files, raw files only or JPEGs only in the editor
setup dialog

o Added "Use camera filenames" option so that images saved to the camera's memory card and to
the PC have the same filenames

o Added more flexible touchscreen options to photobooth mode and the ability to switch between
different sets of photobooth settings

o Added optional release.jpg screen which is displayed immediately before taking a picture in full
screen photobooth mode

o Added support for the Kensington Wireless Presenter in full screen photobooth mode

¢ Fixed problems with saving images to the camera only when using recent cameras

5 August 2009: v1.7.6

¢ Improved the responsiveness of live view controls on low spec PCs or when using slow USB
connections

o Added custom layout option for photobooth prints and the ability to load and save photobooth
settings

e Minor improvements to the focus_stacking script to show progress on screen and extra checks to
detect the camera connection being lost or the live view window being closed.

12 May 2009: v1.7.5
o Added support for Canon EOS 500D/Rebel T1i

o Added an option to only display live view images for the first photo in the photobooth sequence in
fullscreen photobooth mode

¢ Live view images can now be rotated by selecting the orientation from the View menu in the main
window

11 March 2009: v1.7.4

Fixed a problem shooting sRaw with the Canon EOS 40D

Added the ability to play .wav sound files when displaying photobooth prompt screens

Added the ability to specify the number of copies of photobooth prints

Added additional start options for fullscreen photobooth mode to facilitate the use of touchscreens
Added support for the StealthSwitch in fullscreen photobooth mode

9 December 2008: v1.7.3

Fixed a problem connecting to the Canon EOS Rebel XS

Now includes information on how to use external buttons in photobooth mode
Camera can now be turned off when not in use during fullscreen photobooth shooting

Fullscreen photobooth shooting now includes an option to use the mouse for triggering the
photobooth sequence and for switching between B&W or color photos

21 November 2008: v1.7.2
o Added support for the Canon EOS 50D and Canon EOS 5D Mark II

o Added left.jpg, middle.jpg and right.jpg options for more flexible layout of images in photobooth
mode.

5 August 2008: v1.7.1

Added support for the Canon EOS 1000D/Rebel XS/Kiss Digital F

o Now supports portrait orientation live view images in photobooth mode

o Added preview display option to photobooth mode and optional captions on printed images.
o Live view images now optionally upscaled to fill live view window
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24 April 2008: v1.7
o Added support for the Canon EOS 450D/Rebel XSi/Kiss Digital X2

o Added live view, the saving of printed images and optional overlay image to photobooth shooting
mode

o Added camera settings dialog which allows the camera's clock to be synchronized with the PC's
clock and the camera owner string to be set

¢ Error and warning messages now cancel automatically after 10 secs when camera auto-reconnect is
selected

6 February 2008: v1.6.1
¢ Fixed a problem downloading and saving large raw files from the Canon EOS-1Ds Mark Il

December 2007: v1.6

Added support for the Canon EOS-1Ds Mark Ill

New photobooth mode added

Live view now supports horizontal and vertical flipping and 180 degree rotation

e o o N

2 October 2007: v1.5

o Added support for the Canon EOS-1D Mark Il and Canon EOS 40D.

o Added live view display for Canon EOS-1D Mark 11l and Canon EOS 40D. Live view supports
manual focus and contrast detection autofocus and also has optional onion skinning and grid
overlay.

e Long bulb exposures can now be controlled from the PC when using the Canon EOS-1D Mark Ill or
Canon EOS 40D

o Added "Arrange windows" option (Ctrl+A) to help arrange the live view and main windows

25 June 2007: v1.4

o Full support Windows Vista support for Canon EOS 350D/Rebel XT, 400D/Rebel XTi, 20D, 30D, 5D,
1D Mark 11, 1D Mark IIN and 1Ds Mark Il

¢ Fixed problems with Av and Tv dropdown menus following recent Windows updates

16 April 2007: v1.3.2
e Added test and notes for running on Windows Vista
e Updated DSLRRemoteLib.dll interface library

22 December 2006: v1.3.1
o Improved reliability with Canon EOS 20D, 350D, 1D Mark Il, 1D Mark IIN and 1Ds Mark Il cameras.
o Fixed LP5 error at startup on some systems

20 October 2006: v1.3

o Added support for the Canon EOS 400D/Rebel XTi/Kiss Digital X

o Added an option to name auto-bracketed sequences with a letter suffix to make it easier to identify
sets of bracketed images e.g. IMG_0123a.JPG, IMG_0123b.JPG, IMG_0123c.JPG

o Added option to execute a command after completing an auto bracket sequence

o Added BBProDirDisplay.exe utility to allow DSLR Remote Pro for Windows to display images in
BreezeBrowser Pro

e Improved warning message display when PC's disk is full

e Spacebar can now be used to release the shutter (unless keyboard focus is in the comment edit
window)

19 May 2006: v1.2
e Added support for the new Canon EOS 30D
o Added the option to use the new or old Canon libraries to control the Canon EOS 20D, 350D, 5D,
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1D2 and 1DS2
o Fixed autobracketing of images when saving images to the camera's memory card only

e Spot metering mode and picture style can now be selected from the PC when using the Canon EOS
5D

29 December 2005: v1.1.1

o Fixed problem with "H/W error 0x000002" when taking long exposures

o Extended auto bracket interval to 2 stops

o Added "Ignore camera update events" option to Camera menu for more reliable operation when
taking pictures using the camera'’s controls

¢ Fixed memory leak when using auto reconnect

¢ Fixed problem when shooting auto bracket sequences and saving raw+JPEG images to the PC

¢ Fixed a problem with Canon EOS 350D/Digital Rebel XT only downloading thumbnails when
shooting raw images

20 October 2005: v1.1
e Added support for Canon EOS 20D, 350D/Digital Rebel XT, 5D, 1D Mark Il and 1Ds Mark I

o Added HQ display option

e Added color management

o Added auto-bracketing

e Added image renaming plus the ability to name the image using the image comment

¢ Improved reliability when shooting continuous sequences

26 January 2003: v1.0

o First public release with support for Canon EOS D30, D60, 10D, 300D/Digital Rebel, 1D and 1DS
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